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Getting Started

This guide provides step-by-step instructions for lab exercises. Each lab corresponds to a topic 
covered in class and provides students with hands-on experience developing UI components on 
the Predix platform.

Course Prerequisites:
��Courses are intended to introduce developers to using the Predix Platform. It is assumed 

that students have familiarity with:
��Development platforms and frameworks
��Java, HTML, JavaScript, CSS, Angular, Polymer and Sass

Log into the Hosted Environment
��You received an email prior to the start of class with your access code. Use that access 

code to log into 
https://predix.instructorled.training 

��Click the Lab Link and click Connect to the lab
��Click the Log in button (you do not need to change the Login or Password here)
��Click the Yes button to resize the desktop to your screen

 You will see a message that the desktop is being resized and you are connected to the 
remote session. 

 
 
 

Tip: You do not need to provide a password.

Note:  All lab exercises will be completed in this hosted environment on the DevBox.
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How to Copy and Paste in your Environment
��In a Terminal window

��Copy using Ctrl + Shift + C
��Paste using Ctrl + Shift + V

��All other applications 
��Copy using Ctrl + C
��Paste using Ctrl + V
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Lab 1:  Getting Started with Cloud Foundry

Learning Objectives
By the end of the lab, you will be able to:

��Log into Cloud Foundry
��Explore the Predix Service Catalog/Marketplace
��Create a service instance 

Lab Exercises
��Logging into Cloud Foundry, page 2
��Creating a Service Instance, page 5

Cloud Foundry Commands

Command Description

cf login Login to cloud foundry

cf marketplace Display all services in the catalog

cf create-service Create a new service instance

cf apps Display all applications in your space

cf push Deploy an application

cf services Display all service instances in your space
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Exercise 1: Logging into Cloud Foundry 

Overview 
In this exercise you will practice logging in to Cloud Foundry.

Steps 

��Double-click the Terminal window icon on your desktop to open a Terminal window

��Enter this command to log into Cloud Foundry:
 cf login -a https://api.system.aws-usw02-pr.ice.predix.io 

1. Log into Cloud Foundry.

Note: This command logs you into GE's API endpoint for Cloud Foundry.

https://api.system.aws-usw02-pr.ice.predix.io
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��You are prompted to enter your email
��Type in your student account (your instructor will provide this)

��You are prompted to enter your password (your instructor will provide this)
��Press Enter

��You are prompted to select a space
��Enter the number of the targeted space that your instructor provides

2. Enter your Cloud Foundry credentials.

Tip: Your password will not appear on the screen as you are typing.

3. Select a space.
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 The terminal displays the API endpoint, user, and organization and space which you are 
logged into.

You are now logged in.

Tip ~To change your space:
��In the terminal, run this command: 

 cf target -s <Name of the Space>
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Exercise 2: Creating a Service Instance

Overview
In this exercise, you will use Cloud Foundry commands to display all services in the marketplace 
and create an instance of the postgres service in your Cloud Foundry space.

Steps 

��In the Terminal, run this command: 
 cf marketplace 
 All available services appear. You will be creating an instance of the postgres service.

1. Display marketplace services.
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��Enter the command to create your own service instance with the following syntax:
 cf create-service <service> <plan> <your_name-service_name>
 Example: 

��In the Terminal, run the cf services command
 The service instances in your space are listed.

2. Create a new postgres service instance in your space.

3. Display all services instances in your space.



Lab 2: Deploying and Monitoring Applications

 GE Digital Page 7

Lab 2:  Deploying and Monitoring Applications

Learning Objectives
By the end of the lab, you will be able to use the Cloud Foundry CLI (Command Line Interface) 
tool to:

��Add a service
��Monitor a service

Lab Exercises
��Deploying an Application, page 8
��Using a Manifest File to Deploy an Application, page 11
��Managing your Environment, page 14
��Monitoring your Application, page 15

Directions
Complete the exercises that follow. 
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Exercise 1: Deploying an Application

Overview 
In this exercise, you will deploy an application to Cloud Foundry from the command line interface 
(CLI).

Steps 

��To determine your current directory, enter pwd and press Enter

��If you are not in the home directory (/predix), run the command: cd and then pwd again 
to confirm you are in the root directory

��Change to the spring-music directory by entering the command below: 

��Run the command cf push to publish the application instance of the web application
 The command fails because you have not provided the parameters it needs.

1. Change to the spring-music directory in the Terminal window.
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.

��Run the command cf push -h and read through the information presented

��Run the cf push command with the following syntax to correctly publish your 
application: cf push <app-name> -p <path/war_filename>
 Note: You should be in the spring-music directory, which contains the pre-built 
sub-directory with the Web application ARchive (.war), or wrapper file with all of the 
application files required for deployment.

 Your application should successfully publish to Cloud Foundry.
 

Tip: -h is for help. Any command used with -h tells the CLI to return help 
information for the command. You will see the command definition, its syntax, 
and its options (parameters).
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��Enter the command cf a to find the URL of your application 

��Copy your application URL (located in the URL column of the output)
��Open the Firefox Web browser, and paste your application URL 

The Spring Music application displays in your browser.
.

1. Test your application in a web browser
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Exercise 2: Using a Manifest File to Deploy an 
Application

Overview
In this exercise you will edit a manifest file and use it to deploy your application instance. The 
manifest file includes a list of parameters that indicate how the solution should be deployed. 
Some of the parameters are required, and some are optional. You can also provide these 
parameters in the command line, but a manifest file is usually used to reduce the complexity of 
the command, and to save the information for later reuse.

Steps

��Open the gedit text editor from the Applications menu at the top left of the DevBox
��From the Applications menu, select Accessories>gedit Text Editor

��Enter Ctrl + O and browse to the manifest.yml file in the following folder
predix/PredixApps/training_labs/CloudFoundryLabs/cf-spring-mvc-demo

1. Add deployment parameters to the manifest file.
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��Edit the manifest file as follows
��Change the application name to the name of the application (microservice) you created 

in the previous exercise
–  To verify the correct name, enter cf a command and locate your application 

(microservice) name

��Change the path to pre-built/spring-music.war
��Change the service listed to (keep the hyphen and space in the file)

- <your postgres service created in lab 1>

This binds the postgresSQL service to your application (microservice)
��To find your service name, enter cf s (services) in the CLI and look for your 

postgresSQL service
��Save the file to the following folder 

predix/PredixApps/training_labs/CloudFoundryLabs/spring-music

Tip: You are saving the manifest file into the same folder from which you deployed the 
spring-music application earlier so that you can use it to re-deploy the application without 
entering the parameters into the command line.
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 Your file should read as follows (but with your individual service and application names)

��From the spring-music directory, deploy your spring-music service using the cf push 
command
��Navigate to the spring-music directory in the CLI (you can check your directory by 

using the pwd command)
��Run the cf push command (no parameters listed)
��Copy the application URL into the web browser
��Run the cf a command to see the application URL

2. Deploy the application to Cloud Foundry and confirm it is running.
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Exercise 3: Managing your Environment

Overview
In this exercise you will scale, stop, and delete your application instance.

Steps

��In the Terminal, run cf stop <your-application-name> 
 Example: cf stop student55-spring-music

The application stops

��Run cf scale <your application name> -i 3
��Enter the command to scale your application back down to 1 instance

 cf delete <your application name> -r 
 Note: This deletes the application and any orphaned routes from Cloud Foundry.

1. Stop the application in Cloud Foundry.

2. Scale your application up to 3 instances.

Tip: The command to delete an application is shown below. Do not delete this application 
as you will use it in later labs.
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Exercise 4: Monitoring your Application

Overview
In this exercise you will create and bind a logging service instance to the spring-music 
application. You will also create an instance of the Kibana logging service (web application) and 
bind that to the logging service instance. Together, these three will provide a web-interface in 
which you can view spring-music application logs. The relationship is shown below.
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Steps

��Run the following commands in the Terminal
��cf create-service logstash-5 free your_name-logstash

 Replace your_name with your first name. This creates a Logstash service instance.

��cf bind-service your_name-spring-music your_name-logstash
 Use your spring-music application name and the name of the Logstash service instance 
you just created

. 

1. Create a Logstash service instance and bind it to your spring-music application.
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��cf restage your_name-spring-music
 This command re-deploys your application from the Cloud Foundry database.

��Clone the Kibana application from GitHub
git clone https://github.com/cloudfoundry-community/kibana-me-logs.git

 This copies the Kibana logging application to your space

��Use this command to change to the kibana-me-logs directory
��cd kibana-me-logs

��Run this command to deploy the Kibana UI application (change your_name to your first 
name)
��cf push kibana-your_name --no-start --random-route -b 

https://github.com/heroku/heroku-buildpack-go.git

2. Restage your application and clone the Kibana logging application.

3. Deploy the Kibana UI to Cloud Foundry.
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��Run this command to bind the Kibana application to your Logstash service instance
cf bind-service <your-kibana-app-name> <your-service-instance-name>

��Run this command to start the Kibana application
cf start <your-kibana-app-name>

��Use the URL of the Kibana application you just deployed and started in your Web browser 
to test the application

4. Bind the Kibana application to your Logstash service instance and start the application.

5. Test the application.



Lab 2: Deploying and Monitoring Applications

 GE Digital Page 19

Your application shows logging information from your spring-music application.
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Lab 3:  Building a Microservice

Learning Objectives
By the end of the lab, you will be able to:

��Use the manifest file to deploy an application
��Build and deploy a Java microservice to the Predix Cloud
��Provide a UI for the microservice

Lab Exercises
��Adding a Maven Archetype, page 22
��Adding an Additional API Endpoint to a Microservice, page 32

Directions
As part of this lab, you will be building an Alarm Service microservice using a maven archetype. 
The service exposes two endpoints; one fetches data from the alarm table and the other fetch 
data from the hospital table.
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Exercise 1: Adding a Maven Archetype 

Overview 
In this exercise you will build a Java microservice (application) and deploy it to the Predix Cloud.

In this lab we’re testing an application locally before deploying it. To test locally, we’re starting a 
local postgreSQL instance. Once the application is deployed to the Predix Cloud, the local 
database service is no longer needed.

Steps 

��In the terminal, run this command:
sudo /etc/init.d/postgresql-9.3 start

 A notice that postgresql has started appears.

 The local postgres service is started because it is required to build the alarmservice 
project in the Eclipse-STS tool (your next task). This is not the same as the service 
instance of postgres that you created in Cloud Foundry..

1. Start the PostgreSQL service.

Note: Every time you restart the DevBox, the local postgres service is shut down.
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��Open Eclipse-STS by double clicking the icon on the desktop

��From the File menu, select New > Maven Project

��Accept all defaults on the screen and click Next

2. Create a new maven project
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��In the Select an Archetype window, enter alarm in the Filter field
��Select predix-hospital-alarm-service-archetype (the text highlights in blue)
��Click Next

��Enter the archetype parameter as shown below: 

��Click Finish



Predix Developer Boot Camp Lab 3: Building a Microservice

 GE Digital Page 25

 The new alarm service project appears in the Package Explorer.
��In Package Explorer, right click on the project root (alarmservice) and select Run As > 

Maven Install

At the bottom of the console in the center, the message, “BUILD SUCCESS” appears.

��Click the maximize console button to maximize the console window
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 Notice that the name of the output JAR file is alarmservice-0.0.1-SNAPSHOT.jar. This 
is the output of the build that is deployed to Cloud Foundry.



Predix Developer Boot Camp Lab 3: Building a Microservice

 GE Digital Page 27

��In Eclipse, double-click the manifest.yml file under the alarmservice project to open it

��Update the manifest file
��name: Append your first and last name to the service name 

(example: alarm-service-FirstNameLastName)
��path: Make sure the path is: “target/alarmservice-0.0.1-SNAPSHOT.jar”
��services: Change the services element to use the name of the postgres service 

instance you created in Lab 1
��db_service_name: Change the services element to the name of the postgresql 

service instance you created in Lab 1
��Press <ctrl> + <s> to save the file

3. Update the manifest file.

Note: Application manifests provide application deployment parameters to Cloud 
Foundry (how many instances to create, how much memory to allocate, what 
services applications should use, and so forth). 
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��In Eclipse, right click on the project root (alarmservice) 
��Select Properties at the bottom of the menu to open the Properties window
��Copy the alarmservice location (select the text, right-click, copy)

To do this:  If you do not remember the name of the service instance you created in Lab 1, 
follow the steps below to determine the name of your service instance.

��In the Terminal, run the command cf services 
��Under the name column, find the instance service you created

4. Deploy the microservice to the Predix Cloud.
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��In the Terminal, navigate to the alarmservice directory by running this command:
 cd <location of alarm service project>

��Type cd, then paste the copied path from Eclipse 
��Deploy the microservice by running this command:
 cf push
 The Terminal shows the deployment steps of the application. 

��Once it completes, select the URL, right-click and select Copy to copy the URL of your 
application
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��Open the Firefox browser by clicking the Firefox icon at the top of your DevBox

��Paste the URL you copied from the Terminal into your browser
��Append “/alarmservice” to the end of your URL and press Enter

The content of the alarm table appears

5. Test your application in a browser.



Predix Developer Boot Camp Lab 3: Building a Microservice

 GE Digital Page 31

��In the Terminal, run this command: 
 cf logs <yourMicroserviceName> --recent
��Replace <yourMicroserviceName> with your microservice name

 Each log line contains these four fields:
–  Time stamp
–  Log type (origin code)
–  Channel: either STDOUT or STDERR
–  Message

6. View the recent microservice logs.

Tip: To find your application (microservice) name, follow the instructions below:
��In the Terminal, type cf a
��Locate your application name under the name column
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Exercise 2: Adding an Additional API Endpoint to a 
Microservice

Overview
In this exercise, you will create another endpoint for the alarmservice microservice. This 
endpoint will be used to query the hospital table. 

Steps 

��In Eclipse, under the “/src/main/java” directory, right click on the package 
com.ge.predix.solsvc.training.alarmservice.entity

��Select New-> Class

1. Create an Entity.
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��In the Name field type HospitalEntity

��Click Finish
 The entity is created

��In gedit, open the file 
/predix/predixApps/training_labs/fundamentals/Lab2/HospitalEntity.txt

��Copy all content of the file
��In Eclipse, replace everything in your HospitalEntity.java class
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��Press <ctrl> + <shift> + <o> to Organize Imports
��Press <ctrl> + <s> to save the file

��In Eclipse, under the “/src/main/java” directory on the package 
com.ge.predix.solsvc.training.alarmservice.repository

��Right-click and select New -> Interface

2. Create an interface.
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��In the Name field, enter IHospitalEntityRepository, then click Finish

��In gedit, open the file 
/predix/predixApps/training_labs/fundamentals/Lab_2/IHospitalEntityRepository.txt

��Copy all content of the file
��In Eclipse, replace everything in your IHospitalEntityRepository.java class
��Press <ctrl> + <shift> + <o> to Organize Imports
��Press <ctrl> + <s> to save the file
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��In Eclipse, under the package com.ge.predix.solsvc.training.alarmservice, double click 
HospitalAlarmService.java to edit the file

��In gedit, open the file 
/predix/predixApps/training_labs/fundamentals/Lab_2/HospitalAlarmService.txt

��Copy all content of the file
��In Eclipse, replace everything in your HospitalAlarmService.java class
��Press <ctrl> + <s> to save the file
��Press <ctrl> + <shift> + <o> to Organize Imports
��Select java.util.iterator and press Finish, then press <ctrl> + <s> to save the file

3. Add mapping to create the service.
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��In Eclipse, under the package com.ge.predix.solsvc.training.alarmservice.jpa.init, 
double click InitAlarmServiceData.java to edit the file

��Uncomment the use of hospitalRepo by removing (/*) and (*/)
��Uncomment the use of HospitalEntity by removing (/*) and (*/)

��Press <ctrl> + <shift> + <o> to Organize Imports
��Press <ctrl> + <s> to save the file

��In the Terminal, from the alarmservice directory, run this command:
 mvn clean install

��The message “BUILD SUCCESS” indicates the microservice was built successfully

4. Populate the Alarm Service and Hospital data.

5. Compile and deploy the microservice.
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��From the same directory in the Terminal, run this command:
 cf push
 The message “App started” verifies that the application was successfully deployed.

��In Firefox, replace “alarmservice” at the end of the URL with “hospital” and refresh the 
browser

��Your data appears

6. Test your Alarm Service application (microservice).

Tip - If you do not remember the URL of your alarmservice follow the steps below:
��In the terminal run this command:

cf a
��Locate your microservice name under the “name” column and find the URL to 

the right under the “urls” column
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Exercise 3: Updating the Microservice UI 

Overview 
In this exercise you will create a UI microservice to display the data fetched by the alarm service. 
You will use the dashboard seed service pack and modify it to create the UI microservice.

Steps 

��In gedit, open the _settings.defaults.scss file from the 
/PredixApps/training_labs/fundamentals/predix-seed-1.1.3/public/bo
wer_components/px-defaults-design/ folder

��Add the following code to the bottom of the file:
$inuit-enable-table--fixed:true;
@import “px-tables-design/_base.tables.scss”;

��Press <ctrl> + <s> to save the file

1. Import a table design into the project.
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��Open the temperature-template.txt file from the 
/predix/PredixApps/training_labs/fundamentals/Lab_4/ folder
��Copy all contents of the file

��In gedit, open the temperature-card.html file in the 
/PredixApps/training_labs/fundamentals/predix-seed-1.1.3/public/bo
wer_components/px-sample-cards/ folder

��In your temperature-card.html file, replace the <template> </template> tags 
and everything within the tags with the content you just copied

��Open the temperature-script.txt file under in the 
/predix/PredixApps/training_labs/fundamentals/Lab_4 folder
��Copy all contents of the file

2. Edit an existing card to display alarm data.
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��In your temperature-card.html file, replace the <script> </script> tag and 
everything within the tag with the content you just copied

��Press <ctrl> + <s> to save the file

 

Note: The highlighted “hospitalurl” will be used later to get data into the card and 
display it.
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��Open the fetch-data-card-template.txt file from 
/predix/PredixApps/training_labs/fundamentals/Lab_4 and copy all the 
contents

��In gedit, open the fetch-data-card.html file from the 
/PredixApps/training_labs/fundamentals/predix-seed-1.1.3/public/bo
wer_components/px-sample-cards folder

��In your fetch-data-card.html file, replace the <template> </template> tags 
and everything within the tags with the content you just copied

3. Edit an existing card to display hospital data.
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��Open the fetch-data-card-script.txt file in the 
/predix/PredixApps/training_labs/fundamentals/Lab_4 folder
��Copy all contents of the file
��In your fetch-data-card.html file, replace the <script> </script> tag and 

everything within the tag with the content you just copied

��Press <ctrl> + <s> to save the file
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��Open the scope.txt file from the 
/predix/PredixApps/training_labs/fundamentals/Lab4 folder
��Copy all contents of the file

��In gedit, open the data-control.js file from the 
/PredixApps/training_labs/fundamentals/predix-seed-1.1.3/public/sc
ripts/controllers folder
��Replace the entire content of the file with the text you just copied

��Replace the alarm service URL with the URL of your alarm service and save the file

4. Connect the UI to the microservice.

Tip: Be sure to leave “http://” at the beginning and the /alarmservice and /hospital at the end 
when you paste in your replacements.

Tip: To determine the URL of your alarm service, run the cf a command in the terminal. 
Locate your microservice name and find the URL to the right.
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��To start your local server, run the grunt serve command from the 
predix-seed-1.1.3 folder: 

Your browser opens the Predix seed application.
��On the left navigation pane select Cards, then select Data Control
��Verify that the Hospital and Alarm data appear

��In the terminal, press <ctrl> + <c> to stop running your local server

5. Test your microservice locally.

Note: The grunt commands allows you to test your microservice locally before 
deploying it to Cloud Foundry.
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��Create a package for deployment
��In your Terminal, run this command:
grunt dist
 This packages the file.

��Update the manifest file
��In gedit, open the file 

PredixApps/training_labs/fundamentals/predix-seed-1.1.3/manifest.yml
��Append your name to the microservice name

��Press <ctrl> + <s> to save the file
��Deploy the microservice to Cloud Foundry

��In your Terminal run the cf push command and verify that the service has started

6. Deploy the microservice to Cloud Foundry.
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��In Firefox, input your Predix-seed microservice URL into the address bar 

��On the left navigation pane select Cards, then select Data Control
 The Hospital and Alarm data appears. You have successfully modified the two cards to 
display the hospital and alarm data.

7. Test your application (microservice).

Tip: If you do not remember your microservice URL, follow the steps below:
��In your terminal run this command:

cf a
��Locate your microservice name under the “name” column and find the URL to 

the right under the “urls” column
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Lab 4:  Implementing Security in Predix

Learning Objectives
By the end of the lab, you will be able to:

��Create a UAA Service Instance and bind it to an application
��Add a new OAuth2 client
��Create a user
��Create an ACS instance and bind it to an application
��Update an OAuth2 client to work with ACS
��Manage ACS User Access

Lab Exercises
��Create a UAA Service Instance, page 49
��Fetch a UAA Token, page 52
��Adding a Client and Users to UAA, page 56
��Create an ACS Instance, page 64
��Bind your Application to the ACS instance, page 66
��Update an OAuth2 Client to Work with ACS, page 68
��Manage ACS User Access, page 72
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Exercise 1: Create a UAA Service Instance

Overview 
In this exercise you will create an UAA service instance and bind your Spring-Music application to 
that instance. UAA is the Cloud Foundry service that manages users and OAuth2 clients. It is 
primarily an OAuth2 provider and issues Java web tokens for client applications to use when the 
applications act on behalf of users. The UAA instance serves as the trusted issuer of tokens and 
all access to services is provided by authenticating through this trusted issuer.

Steps 

��In the Terminal run the command: 
cf marketplace

��The predix-uaa-training* service is listed along with its Plan name and description

*For training only. In production, you will use the predix-uaa service

1. Verify the UAA service is available in the marketplace.
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When you create a UAA service instance, you create the administrative user (client) with its 
password. The name of this client is “admin”.

��In the Terminal, create a UAA service instance with the following syntax:
cf create-service predix-uaa-training <plan> <uaa_instance> -c 
'{“adminClientSecret”:”<admin_secret>”}'

��Replace <plan> with the plan name 

��Replace <uaa_instance> with an instance name of your choice
��Replace <admin_secret> with a password of your choice

��Verify a status of OK is returned
 Example:

��Write down the admin password as you will use it in later labs: _________________

��In the Terminal run the command: 
 cf bind-service <Spring-Music-app> <uaa_instance>

��Replace <Spring-Music-app> with your Spring-Music application name
��Replace <uaa_instance> with name of your instance

2. Create a UAA service instance.

Note: Use the “Free” plan type to ensure all labs function properly.

WARNING: There is no way to determine this password later on; do not rely on your memory!

3. Bind your previously-created Spring-Music application to your UAA service instance.
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��A return status of OK indicates the application was successfully bound
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Exercise 2: Fetch a UAA Token

Overview 
In this exercise you will use the UAA Command Line Interface (UAAC) to fetch a token from the 
UAA service instance created in the previous lab. The UAAC has been installed on your DevBox.

Steps 

��In the Terminal run the command: 
cf a

��Locate your application in the list and verify it has started

 When you bind your app to the UAA instance, the connection details for your UAA 
instance are populated in VCAP_SVCS environment variables.

��In the Terminal, run the command:
cf env <app_name>

��In the VCAP_SERVICES variable, locate the entry for your UAA service instance
��Copy the UAA environment variables to a new file in your text editor for later use

1. Find your sample application name in the space.

2. Retrieve your UAA instance details from the VCAP_SERVICES environment variable.

Note: Look for the name of your service instance (example: cf-uaa)
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��Under the credentials section, copy the uri value for your service instance (copy the string 
between the quotes)
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��In the Terminal run the command:
uaac target <uri>

��Replace <uri> with the uri of your UAA instance

 

��In the Terminal run the command to log in using the administrative client:
uaac token client get admin -s <admin_secret>

Note: The admin client is the default client id that has all permissions
��Replace <admin_secret> with the password you created when creating the service 

instance
A successful fetch notice indicates you have retrieved the token

��You are now logged in as the administrative client

3. Specify your UAA instance as the intended target.

Note: You must first point the uaac CLI tool to your UAA service instance in order to 
view the UAA instance details.

4. Fetch a UAA token from your UAA instance.
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��In the Terminal run the command:
uaac token decode

��The token contains basic information including
��scope - a list of authorities for the admin client
��client_id - unique name to the system for the client id
��Authorization grant type - mode of authorization

5. Decrypt the token to view its contents.
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Exercise 3: Adding a Client and Users to UAA

Overview 
In this exercise you will create an OAuth2 client you use to create users for in your UAA instance. 
When you create a UAA service instance, a default administrator account (admin client) is 
automatically generated that contains all permissions. As a best practice, you create an Oauth2 
client and define the scopes instead of using the admin client to create users.

For service-to-service security, the generally-recommended grant type is “client_credentials”. 
for web applications, the recommended grant type is “authorization_code”

Steps 

��In the Terminal, run the command: 
uaac client add -h

This displays all parameters available to create a new OAuth client
��To create the OAuth 2 client, the command line syntax is:
 uaac client add <client_name> -s <client_secret> 
--authorized_grant_types “<grant_types>” --autoapprove openid 
--authorities “<list of client scopes>”

��Replace <client_name> with your client name and write it here _______________
��Replace <client_secret> with your chosen password and write it here_________
��Replace <grant_types> with authorization_code client_credentials 

refresh_token

��Replace <list of client scopes> with clients.read clients.write scim.read 
scim.write

 

1. Create an OAuth2 client with a subset of admin permissions.
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 Example: 



Lab 4: Implementing Security in Predix

 GE Digital Page 58

��In the Terminal, run the command:
 uaac token client get <client_name> -s <client_secret>

��Replace <client_name> with the name of your new oauth2 client
��Replace <client_secret> with the password you created when creating the uaa 

client
��Verify the token was fetched successfully - you are now logged in as the new client

Alternatively, you can exclude the -s portion of the command, and you will be prompted to enter 
the client secret. This is more secure since the password is not displayed as you login as the new 
client.

2. Fetch a token for the new OAuth2 client.
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��In the Terminal, run the command: 
uaac user add -h

This displays all parameters available for creating a new user
��In the Terminal run the command:
 uaac user add <user_name> --emails <user_email> -p <user_password>

��Replace <user_name> with a value of your choice, preferably the email
��Replace <user_email> with the email of the user (e.g. user1@test.com)
��Replace <user_password> with a value of your choice

��Write down the user name: _____________________________________
��Write down the email: __________________________________________
��Write down the user password: __________________________________

 You will use these later on in the lab.

3. Add a user to your UAA service instance.

Analysis: For applications accessing your UAA instance, you can create additional 
users with required scopes. You must be logged in as a client with the necessary 
authorities.
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��Give your user read and write privileges (group names are scim.read and scim.write - the 
user token (permission) must have the same name as the group).

uaac group add scim.read
uaac group add scim.write

 Sample code:

uaac member add scim.read <user_name>
uaac member add scim.write <user_name>

4. Create the groups in your UAA instance.

5. Add the new user to the required groups.
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��To view all users, run the command: 
uaac users

 The user now has access to the UAA zone

6. View user details.uaa
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 To view the page your user should see when they try to log into an application, paste the 
uri of your UAA instance into a browser and append /login at the end

��At the Predix login screen, enter the user name (not email) and user password
��Click Sign in

��The login is successful, but an error message is displayed

7. View the UAA login page.
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 If the redirect_uri had been set you would have been directed to your application.

Note: When creating the new client, we did not specify a redirect attribute. You can add 
the redirect by updating the client.
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Exercise 4: Create an ACS Instance

Overview 
In this exercise you will create an ACS instance, and bind your application to the instance.

Steps 

��In the Terminal run the command: 
cf marketplace

 The predix-acs-training service is listed along with its Plan name and description

��

1. Verify that the UAA service is available in the marketplace.
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��In the Terminal run the command to create a service instance with the following syntax:
cf create-service predix-acs-training <plan> <my_acs_instance> -c 
'{“trustedIssuerIds”:”<uaa_instance_issuerID>”}'

��Replace <plan> with the plan name (e.g. Tiered, Basic, Free)
��Replace <my_acs_instance> with an instance name of your choice
��Replace <uaa_instance_issuerID> is the issuerID (not the uri) of your UAA 

instance that you saved when you created your UAA instance.
��Verify a status of OK is returned

Example:

 

2. Create an ACS service instance.

Note: You will use the training version of ACS for this exercise rather than the 
production version.
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Exercise 5: Bind your Application to the ACS 
instance

Overview 
You must bind your application to your ACS instance to provision its connection details in the 
VCAP_SERVICES environment variable. 

Steps 

��In the Terminal execute the command:
cf bind-service <Spring-Music-app> <my_acs_instance>

��Replace <Spring-Music-app> with your application name
��Replace <my_acs_instance> with your ACS instance name

Example:

1. Bind your application to the new ACS instance.
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��Verify the binding:
cf env <your_app_name>

 Notice the label is predix-acs-training and the name is cf-acs
 

��Copy the ACS information into your text editor file. You need the OAuth scope to configure 
the OAuth client to work with ACS.
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Exercise 6: Update an OAuth2 Client to Work with 
ACS

Overview 
To enable applications to manage policies and attributes using ACS, you need to update your 
OAuth2 client with the required OAuth2 scopes and authorities. In this exercise, you will 
establish your OAuth2 client to handle Policy Management Services. This will handle tokens 
sent by the application or client.

Steps 

��Login as admin to make these changes. Run the command:
uaac token client get admin

 Specify the admin password (<admin_secret>) when prompted
.

 

1. Update your Client to work with ACS



Predix Developer Boot Camp

Page 69 Predix Training Programs

��Run the command:
uaac clients

 Note the client authorities in both the admin client and the client you will use for your 
application (cf-client in this case).
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��Build the uaac client update --authorities command so that the OAuth client 
has the appropriate authorities to work with your ACS service instance 
��Open a new file in your gedit text editor and enter the update command
��Enter a space and double quote after the --authorities flag
��List all the authorities (single space in between), including those that the client already 

has
–  Original list, from your client environment variables (see prior page graphic):
clients.read clients.write scim.write scim.read 

–  Enter a space, then enter the zones.<UAA_uri>.admin variable listed under 
the admin authorities (see prior page graphic)

–  Enter a space, then enter the required ACS scopes:
acs.policies.read acs.policies.write acs.attributes.read 
acs.attributes.write

<oauth-scope> (from the application environment variable for ACS)
��End your command with a double quote

 Example:
 

��When prompted, enter the client name you created 
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 Sample results for updating the OAuth2 client:
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Exercise 7: Manage ACS User Access

Overview 
Your client will manage the resources for Attribute Management Services, and the account and 
permissions will need to be set up. You created a user in a previous lab. When your user logs in 
and creates a report, the user will need read permissions.
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Steps 

You can use Admin to create groups, although as a best practice, you should use your application 
client to manage policies and attributes in your application. You updated your application client 
in Exercise 3 to enable that client to manage ACS attributes and policies.

��Ensure your UAA instance is the intended target
uaac target <uri>

��Logon as the administrative client
uaac token client get <app client>

 Specify the <client_secret> when prompted

��Create the groups required for ACS in UAA:
uaac group add acs.policies.read
uaac group add acs.policies.write
uaac group add acs.attributes.read 
uaac group add acs.attributes.write
uaac group add <acs_oauth_scope>

 Where <acs_oauth_scope> is the ACS oauth‐scope environment variable 
 

1. Create the groups required for ACS in UAA.
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��User the uaac users command to find the user created previously
��Assign membership to the required scope:

uaac member add acs.policies.read <user_name>
uaac member add acs.policies.write <user_name>
uaac member add acs.attributes.read <user_name>
uaac member add acs.attributes.write <user_name>
uaac member add <acs_oauth_scope> <user_name>

 
 You will see a message indicating you have succeeded assigning membership to your 
user.
 
 The user is now able to authenticate through ACS Policy Management, Attribute 
Management, and Policy Evaluation services.

2. To use the Policy Management service the user/client must authenticate using a JSON Web 
Token (JWT) bearer token that includes the acs.policies.read scope for reading the policies 
or the acs.policies.write scope for writing the policies. To use the Attribute Management 
service, the user/client must authenticate using a JWT that includes the acs.attributes.read 
and the acs.attributes.write scopes.
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Lab 5:  UI Basics

Learning Objectives
By the end of the lab, students will be able to:

��Add a link and route for the Patients page to the Predix Starter Pack
��Show data in a table
��Customize the px-theme component to style the application
��Customize a reusable Predix web component
��Use the customized component in your application
��Fetch data from a Polymer web component

Lab Exercises
��Adding a Route using Angular JS, page 77
��Creating a Controller, page 82
��Changing the View and Model, page 84
��Styling Your Application, page 87
��Creating a View to Display a Web Component, page 93
��Creating a Web Component, page 96
��Connecting a Microservice, page 102

Directions
Complete the exercises that follow. 

Note: The code for these exercises is found in the UILab.txt file. Your instructor will provide 
you with the path to this file.
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Exercise 1: Adding a Route using Angular JS

Overview 
In this exercise you will start up the predix seed web application and add a new page to the 
application, using the Predix Angular UI-router. (This is not the built-in router Angular JS ships 
with.) You will add a new Angular controller and use it to add data to the page. 

Steps 

��In the Terminal, use the following command to navigate to the predix seed app:
��cd ~/PredixApps/training_labs/fundamentals/predix-seed-1.1.3

��Run the following command to start the local web server
��grunt serve

The command line interface (CLI) responds with several lines, ending as follows.

Note: The Predix seed application is already installed, along with its required npm and 
bower installations. Normally, you would run npm install and bower installs after saving the 
seed application files to your directory.

1. Test the application locally.
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The web browser opens and loads the predix starter web application

Leave the grunt watch running in your Terminal. To run additional commands in the 
Terminal, open a new window using the File menu (File>Open Tab).

Note: Press <Ctrl> + <C> when you need to do something else in your Terminal. This stops 
the watch task of the grunt serve command.
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On the left side of the web page, there is an existing navigation component. You will add a new 
link called Patients

The code provided adds an Angular UI route which is used to associate a view and a controller 
with a URL. The routes.js file contains all of the routes for the application and you will add a 
new state in this file.

As noted previously, to copy and paste code into your application files, open the UILab.txt file in 
the gedit text editor and refer to it for the duration of the lab. This file is in the 
predix/PredixApps/training_labs/fundamentals folder.

2. Add a new navigation link (route).

Note: The paths noted in the lab instructions assume you are starting in the 
predix-seed-1.1.3 directory unless otherwise directed.
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��In your text editor, navigate to the public/scripts directory (under the 
predix-seed-1.1.3 directory)
��Open the routes.js file
��Add a new state to the file 

–  Remove the semicolon after the components statement
–  Paste in the code provided at the end of the $StateProvider section just after 
/components.html

 Ensure that your code reads exactly as below:

��Save the file (<Ctrl + S>)

��Create a new link
��In your text editor, navigate to the public/scripts directory
��Open the app.js file
��Add a comma after label: ’Data Control’}
��Add the code provided to the tabs array

This code defines router paths and is where the name of the route is matched to the controller 
and view template.

 
 Your code should read as follows:

3. Create a new link (tab) in the navigation and add some data for display in the view.
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��In the same file, store some dummy data for display in the view
��Locate this line in the file:
 predixApp.controller('MainCtrl', ['$scope', 
'$rootScope',function,...

��After this line, paste the code provided into the root scope
Your code should read as follows:

��Save the file

4. Store some dummy data for display in the view.
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Exercise 2: Creating a Controller

Overview 
In this exercise, you add the Patients controller to the application.

Steps 

��In your text editor, navigate to the public/scripts/controllers directory in the 
seed application
��Create a file called patients.js and paste the code provided into the file

Your code should read as follows:

��Save the file
This code defines the Patients controller (PatientsCtrl), the add.Patient function, and the form 
(model)

1. Create the new patients controller in the patients.js file.
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��In your text editor, navigate to the /public/scripts/controllers directory
��Open the file main.js file
��Paste the code provided into the file, replacing all code

 This reference ensures that the new controller is loaded into the browser.
��Save the file

��Create a new directory called patient in the public/views folder
��Create a new file in the patient folder called index.html
��In your text editor, navigate to the public/views/patient directory

��Open the index.html file
��Paste the code provided into the file
��Save the file

This view uses the Angular ng-repeat directive to iterate over the list of patients in 
scope.

��Refresh the browser and the application appears with the new navigation link and the 
patient data

2. Add a reference to the new controller.

3. Create a new view to display a table of patient data.
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Exercise 3: Changing the View and Model

Overview
In this exercise, you will add a form (with two name fields) that allows the user to dynamically 
change the view and the model (data) on the web page. You will add First Name and Last 
Name input fields and an Add Patient button to allow users to add patient data to the table. 
Finally, you will add a search field to provide filtering.

Steps

��In your text editor, navigate to the views/patient directory
��Open the index.html file 
��Enter the code provided after the <h2> tag

Your code should read as follows:

��Save the file
��Refresh your browser

1. Add Name entry fields and an Add Patient button.
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 Your web page should look similar to the one below:

��Add some patient First and Last Names to test your page
The Add Patient button should submit the names to your list.

��In your text editor, navigate to the public/views/patient directory
��Open the index.html file
��Add the code provided after the <br/> tag 

��Find the following line in the same file:
 <tr ng-repeat=”patient in patients”>

��Replace the line with the code provided 

2. Add a search field to filter the patient data on the page.

3. Iterate over the patient table.
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��Save the file
��Refresh the browser
��Navigate to the Patients page and test the search/filter functionality

The application allows you to add multiple patient names and filter on them.
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Exercise 4: Styling Your Application

Overview 
In the last lab, you created a Patient Input Form without any styling. In this lab, you’ll use Predix 
styles to give the form a nice look and feel. 
Normally, you use the GitHub repository to copy Predix projects (web parts, components, 
elements) to your laptop. We have already staged the px-theme, px-library-design, 
px-forms-design, and the generator-px-comp projects on your DevBox. All of the projects’ 
dependencies have also been installed using npm install and bower install. To see the actual 
steps for this, see the Installing Px Theme Components from GitHub section in the Appendix 
at the end of this guide.

Steps.

��From the predix/PredixApps/training_labs/fundamentals/px-theme 
directory in the Terminal, run the grunt command

The Sass pre-processor generates the CSS files, including the px-forms-design 
component.

��Open a new Terminal window by selecting Open Tab from the File menu
��Run the grunt watch command from the/px-theme/sass directory
��In your text editor, navigate to the px-theme/sass directory
��Open the px-page-theme.scss file

1. Generate the CSS files and add the px-forms-design component.

Tip: Grunt is a command line tool that runs tasks for JavaScript. Here it assures that the Sass 
files generate the appropriate CSS. In the next step, the grunt watch command ensures 
that CSS files are updated as changes are made to .scss files. This allows you to immediately 
see your code changes in the web application.
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��Insert the code provided just above the //App line so your code appears as follows:

��Run the following commands in the Terminal:
��From the /predix/PredixApps/training_labs/fundamentals/px-theme 

directory, run the bower link command
��From the predix-seed-1.1.3 directory, run bower link px-theme

These commands link your px-theme project to the predix-seed-1.1.3 project directly.
��Reload the “Patients” page in your browser

Tip: You may need to run the grunt serve command in the predix-seed-1.1.3 
directory again.
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Your Patients page appears as below:
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��In your text editor, navigate to the predix-seed-1.1.3/public/views/patient 
directory
��Open the index.html file, and replace all of the HTML from and including the 

<form> tags with the code provided
 Your code should appear as follows:

If you reload the browser now, you will not see the changes because the input--small and 
btn--primary classes are not included by default. Px only includes classes you want to use.

��To include these classes, in the px-theme/sass directory, open the 
px-page-theme.scss file.
��Add the code provided in the //Objects section on the line after 

“$inuit-enable-btn--bare” 

2. Add classes to the HTML.

3. Add the class to your project - primary button.
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��Add the code provided in the same section on the line before 
@import “px-forms-design/_base.forms.scss”;” and save

 Your code should appear as follows:

��Reload the page in your browser

4. Add the class to your project - small input.

Note: Be sure to place the code exactly as instructed in the .scss file because line order is 
critical.
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 Your Patients page should have a new blue button and nicely formatted, small text fields.
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Exercise 5: Creating a View to Display a Web 
Component

Overview 
In this exercise, you will create a view in order to display a hospital web component. The web 
component displays the number of hospitals within the network. In order to create the view, you 
create another new state for the Angular UI router to use. You will also create a new link to be 
able to navigate to the view. Finally, you will add a controller with some dummy data to display in 
the view.

Steps

��In your text editor, navigate to the predix-seed-1.1.3/public/scripts directory
��Open the routes.js file 
��Add a new state to the file 

–  Remove the semicolon after the components statement
–  Paste in the code provided at the end of the $StateProvider section and save the file

 Ensure that your code reads exactly as below:

1. Add a new state.
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��In your text editor, navigate to the public/scripts folder
��Open the apps.js file 
��Add the given state and label information to the tabs array and align the text (using 

spaces) underneath the prior state information
��Add a comma after ’Patients’}

Your code should read as below:

��Press <ctrl> + <s> to save the file

��In your text editor, navigate to the public/scripts/controllers directory
��Create a new file called hospitals.js
��Paste in the code provided to create the controller

 The file includes some dummy hospital data.
��Save the file as hospitals.js

2. Create a new Hospital link for the view.

3. Add the controller for the view.
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��In your text editor, navigate to the public/scripts/controllers directory
��Open the main.js file 
��Replace all of the contents of the file with the given code.
��Press <ctrl> + <s> to save the file

��In your File Finder, navigate to the public/views directory and create a new folder called 
hospital

��Create a new index.html file there
��Open the file with your editor and enter the code provided
��Save the file 

��Open your browser, refresh your page and navigate to the Hospitals link.
You should see a tab with the text, “There are 2 hospitals within this network.”

4. Add a reference to the new controller.

5. Create the view to display the hospital web component.

6. Test your application locally.
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Exercise 6: Creating a Web Component

Overview
In this exercise, you will customize a Predix component and connect it to the seed application. 
We have staged the component on the DevBox for you.
Normally, you would download and install the component and its dependencies from GitHub 
and then generate the component using a Predix component Yeoman generator. This 
component renders a simple HTML table that displays hospital data. The Yeoman generator 
allows developers to specify how to build their web application. It uses the yo scaffolding tool 
from Yeoman as well as a package manager like bower or npm, and a build tool like Grunt.
To see the actual steps for this, see the Creating a Web Component section in the Appendix at 
the end of this guide.

Steps

��In the Terminal, change directories and start the local test by running these commands
��cd ~/predix/PredixApps/training_labs/fundamentals/hospital-info
��grunt firstrun

The grunt firstrun command interprets the Sass into CSS and starts a local web 
server to test the component by itself.

��Click the DEMO link in the upper right hand corder to see the web component

1. Test the web component locally.
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��Click the number to increment it and test the demo page

��Open a new Terminal window by selecting Open Tab from the File menu in the Terminal

��Run the command: grunt watch
 This tells the grunt service to look for changes in the project. It automatically processes the 
Sass code (.scss files) into CSS as you make changes.

2. Tell the grunt service to watch for project changes.
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��In your text editor, navigate to the 
/training_labs/fundamentals/hospital-info/sass/directory

��Open the hospital-info-sketch.scss file
��Replace the Component section with the code provided 
��Save the file

��Navigate to the /training_labs/fundamentals/hospital-info directory
��Open the hospital-info.html file
��Replace the <dom-module> section with the code provided 
��Save the file

��In the same file, replace the <script> section with the code provided
��Save the file
��See the next page to make sure your code is correctly placed.

3. Replace the code in the component section of the hospital-info-sketch file.

4. Replace the dom-module section in the hospital-info.html file.

5. Replace the script section in the hospital-info.html file.
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 Your file should read as follows:
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��In the Terminal, run these commands:
��(from the hospital-info directory) bower link
��cd ~/PredixApps/training_labs/fundamentals/predix-seed-1.1.3
��bower link hospital-info

��In your text editor, navigate to the predix-seed-1.1.3/public directory 
��Open the index.html file
��Add the code provided at the end of the <card.html> section as follows 

��Modify the <h1> tag, after the svg> tag, replace the word “Predix” with a name for 
your app, such as “My Healthcare System” 

��Save the file

��In your text editor, navigate to the predix-seed-1.1.3/public/views/hospital 
directory
��Open the index.html file 

6. Connect the hospital-info component to the seed app.

7. Add the px-card to show hospital information in the project.
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��Add the code provided to the bottom of the file and save the file

��Run grunt serve from the predix seed directory to see the new component:

This component can be used anywhere in your application. You could use it in a different 
application by installing it into that application using bower install. In future, there will be a 
Predix web component catalog for sharing your work with other teams.
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Exercise 7: Connecting a Microservice

Overview
Before Polymer components, most API calls were made from Angular controllers or services and 
this is still a supported pattern in Predix. However, in this exercise, you will fetch data from a 
Polymer iron-ajax element.
You use the following syntax to bring data into a Polymer web component. You use the URL of a 
microservice to do this, but in our lab we’ll bring data in from a json file as the URL.

 <iron-ajax auto url=”{{microservice_Url}}” 
 last-response=”{{data}}”></iron-ajax>

Connecting from a Polymer Web Component

��In a Terminal window, change to the predix-seed-1.1.3 directory and run the 
following command:

bower install polymerelements/iron-ajax --save
��Enter 1 when prompted

This command installs the polymer iron-ajax element. It also provides a reference to 
the polymer iron-ajax elements in the bower.json file. 

1. Install a Polymer element.
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��Navigate to the index.html file in the 
predix-seed-1.1.3/public/views/hospital folder

��Replace all of the code in the file with the code provided and save the file. 
Note that the hospital-details jason file (object) is in place of a URL that would normally 
provide an endpoint into a microservice.

 
The options used below the <iron-ajax tag are auto, url, handle-as and 
last-response. The auto option tells the system to make the rest call when the iron-ajax 
element loads or when the URL or params options changes. The URL tells the program 
to go to that location to get data. Handle-as tells the program if the data returning will 
be XML, json, a blob, a document, or other data type. Last-response refers to the most 
recent response from the ajax request.

��In the predix-seed-1.1.3/public create a file called hospital-details.json
��Copy and paste the code provided into the new file and save it. 
��In the Terminal, from the predix-seed-1.1.3 directory, run the grunt serve 

command
The details in the hospital-details file display in the Polymer element in the web 
browser.

2. Use the iron-ajax component to fetch data and pass the info to the hospital-info 
component.

3. Create a mock-data file to replaces data coming from a URL).
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Lab 6 :  Using the Asset Service

Learning Objectives
By the end of this lab, students will be able to:

��Create an Asset service instance in Cloud Foundry
��Bind an application to an Asset service instance
��Login as the administrator client
��Add a new client
��Create a user
��Invoke Service Asset APIs to retrieve, add and delete asset objects
��Use JSON to define asset objects
��Construct filters using Graph Expression Language to query assets

Lab Exercises
��Creating an Asset Service Instance, page 109
��Binding to Your Asset Service Instance, page 111
��Fetch a Token from the UAA Service, page 113
��Retrieve Asset Model Data, page 118
��Add an Asset to the Asset Model, page 122
��Link Domain Objects, page 125
��Delete an Asset from the Asset Model, page 127
��Construct GEL Queries, page 128
��Constructing Transitive Closure Queries, page 132

Directions
Complete the exercises that follow. 
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Exercise 1: Creating an Asset Service Instance

Overview 
To use a Predix Service, you must first create an instance of the service in Cloud Foundry. This 
first exercise provides you with the steps to create an instance of the asset service using the 
trusted issuer ID from the UAA instance you created previously. A text file called Asset_Lab.txt 
has been placed in your environment for you to copy some of the commands used in this lab.

Steps

��In the Terminal run the command: cf marketplace 

1. Display all services in the Predix marketplace.

Analysis: The Asset service is available in the Service catalog. To use the Asset service, 
you will first need to create an instance of the service in your space. This is done using 
the cf create-service command.
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��In the Terminal run the cf create-service --help command to display a list of required 
arguments:
cf create-service predix-asset <plan> <asset_instance> -c 
'{“trustedIssuerIds”:["<uaa_url>”]}'

where:
–  Replace <plan> with the plan name (e.g. Beta, Free)
–  Replace <asset_instance> with an instance name of your choice
–  <uaa_url> - IssuerId from your UAA instance created earlier

��Your command will look similar to this:

��To list all services in your training space, run the command:
cf services

Your instance of the Asset service should now be available in the training space.

2. Create an Asset service instance.

3. Verify the Asset service instance was created in your training space.
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Exercise 2: Binding to Your Asset Service Instance

Overview
In this exercise you will bind your Spring-Music application to your Asset service instance. 

Steps 

��In the Terminal run the command:
cf bind-service <Spring-Music-app> <AssetService_YourName>

Where <Spring-Music-app> is the name of your Spring-Music application
Where <AssetService_YourName > is the name of your Asset service

 Note: you can abbreviate the command cf bind-service as cf bs
 For example:

1. Bind your sample application to your Asset service instance.
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��In the Terminal run the command: cf s
��Your service instance should now be listed and bound to the sample application

��In the Terminal run the command:
cf env <Spring-Music-app>

��The uri field displays the REST endpoint for your Asset service instance

2. Verify that your application is bound to your asset service instance. 

3. Display environment variables for your application.
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Exercise 3: Fetch a Token from the UAA Service

Overview
To access and update asset model data, users require a UAA token. Here, you use the REST client 
to request the token from the UAA Service. The token needs to be added to every data request to 
the Asset Service. 

Note: Even though you have created an Asset service instance, you will use a pre-configured 
asset service instance so that you can search across data that has already been loaded.
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Steps

��In Firefox, launch the REST client (click on the red icon shown here)

��You will build a POST request that looks like this: (steps on next page)

1. Launch the REST client.
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��Set the Method and URL (copy and paste this from the Asset_Lab.txt file)
��Method: POST (select from drop-down)
��URL:
https://299fbc8e-3050-4392-8047-86d3fcc5a145.predix-uaa.run.aws-us
w02-pr.ice.predix.io/oauth/token

��Click on the Authentication drop-down and select Basic Authentication

��Enter the user name: training_client
��Password: training_secret
��Click Okay; a new authorization header has been added 

2. Begin configuring the POST request.

WARNING: When pasting text from a PDF, spaces are inserted into the URL at line breaks. 
Remove any spaces before continuing on to the next step!

3. Add username and password credentials as a header.
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��In the Headers drop-down, select Custom Header
��Enter the name: Content-Type
��Enter the value: application/x-www-form-urlencoded

–  Click Okay; a second header is added

��In the Headers drop-down, select Custom Header
��Enter the name: x-tenant
��Enter the value: eaccfb4a-6ee6-4df1-acab-afbe41aaa506

��In the Body section enter the following:
client_id=training_client&grant_type=client_credentials&client_sec
ret=training_secret

��Click the Send button
��A return code 200 OK indicates the request was successful 

4. Add a Content-Type header.

5. Add an x-tenant header.

6. Construct the body of the response message.
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��Under the Response section, select the Response Body (Highlight) tab
��Copy the UAA token as shown: (only copy text within the quotes, not the quotes 

themselves
)

��You will use this token in the next lab to retrieve assets from the asset mode

7. Copy the token from the response for later use.
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Exercise 4: Retrieve Asset Model Data

Overview
In this exercise you retrieve locomotive asset objects using the Asset Service APIs. 

Steps

��Open a new tab in Firebox and open the REST client
��In the REST client set the Method and URL settings

��Method: GET
��URL: 

https://predix-asset.run.aws-usw02-pr.ice.predix.io/locomotive

��Add a Custom Header 
��Name: Content-Type 
��Value: application/json

��Add a second Custom Header 
��Name: Authorization 
��Value: Bearer <paste the Token returned by UAA>

1. Create a GET request for all locomotive objects.
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��Add a third Custom Header
��Name: x-tenant
��Value: eaccfb4a-6ee6-4df1-acab-afbe41aaa506

��Send the request; verify a status code of 206 Partial Content is returned in the Header 
Request



Lab 6 : Using the Asset Service

 GE Digital Page 120

��Select the Response Body (Preview) tab to view locomotive assets returned

2. Review the returned asset data.
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��In the Response Body (Preview) tab, copy the JSON code for the first locomotive asset as 
shown here

��Include the starting bracket "[" and the closing brace "}," for the asset

3. Copy JSON for a single asset (for use in next exercise).
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Exercise 5: Add an Asset to the Asset Model

Overview
Post a request to add a new locomotive asset to your asset model.

Steps

��Open a new tab in Firefox and open the REST client
��Change the Method to POST 
��Verify the URL:
https://predix-asset.run.aws-usw02-pr.ice.predix.io/locomotive

��Add a Custom Header 
��Name: Content-Type 
��Value: application/json
��Click Okay

��Add a Custom Header
��Name: x-tenant
��Value: eaccfb4a-6ee6-4df1-acab-afbe41aaa506

��Add a Custom Header 
��Name: Authorization 
��Value: Bearer <paste the Token returned by UAA>

 TIP: Copy and paste the UAA token from the browser tab where you created your first 
POST request

1. Use the POST method to add a new asset.

2. Add authentication and content-type headers.
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��Paste the contents of the asset you copied into the Body of the request
��Make the following changes to the JSON

��uri: replace locomotive/1 with locomotive/your_name
��serial_no: replace the existing value with a value of your choice
��model: enter a value of your choice

��Remove the comma after the closing curly brace "}"
��Add a closing bracket "]" after the last curly brace "}"

��Send the request
��In the Response Headers tab a 204 No Content status code is returned, indicating the 

asset was successfully added

3. Construct the body of the message.
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��Select the browser tab that contains the GET request for all locomotive assets
��Append the name of your new locomotive asset to the end of the URL (in our example, the 

name is /testuser)

��Send the request
��Select the Response Body (Highlight) tab to view the returned locomotive asset

��This verifies that you successfully added a new asset to the asset model

4. Submit a GET request to retrieve the new asset from the asset model.
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Exercise 6: Link Domain Objects

Objective
In this exercise you link your new locomotive asset object to a different manufacturer object. 

Steps

��In the REST client change the Method to: PUT
��URL: verify it points to your locomotive object (our example uses /testuser):

https://predix-asset.run.aws-usw02-pr.ice.predix.io/locomotive/<
your_asset>

��Copy the asset information from the response section to the Body section, and change the 
manufacturer property to point to cummins

Note: The PUT operation requires you to specify all attributes for an asset

��SEND the request
��Verify a status code 204 OK is returned

1. Link the locomotive asset to a different manufacturer.
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��In the REST client change the Method to: GET
��SEND the request
��In the Response Body (Raw) tab, verify the manufacturer property now references 

cummins:

2. Send a GET request to verify the new link.
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Exercise 7: Delete an Asset from the Asset Model 

Overview
In this exercise you use the DELETE API method to remove the locomotive asset (added in the 
previous exercise) from the asset model.

Steps

��Update the GET request
��Change the Method to DELETE 
��Use the existing URL that points to your new locomotive asset

��Send the request
��In the Response Headers tab, a return code of 204 No Content indicates the Delete 

operation was successful

��In the REST client change the Method to GET
��Send the request
��In the Response Headers tab, the response code should be 404 Not Found

This indicates that the asset was successfully deleted 

1. Use the DELETE method to remove an asset from the asset model.

2. Submit a GET request to verify the asset was deleted.
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Exercise 8: Construct GEL Queries

Overview
In this exercise you construct different GEL queries to control asset data returned by GET 
requests.

Steps

��In the REST client, verify the Method is: GET
��Verify the request URL references the /locomotive domain object
��Append the following fields clause to the end of the URL

?fields=uri,model,manufacturer

��SEND the request
��Select the Response Body (Preview) tab to view the results

1. Add a fields clause to display selected fields for locomotive objects.
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��In the RESt client, append the following filter clause to the end of the URL
?filter=type=Diesel-electric

��SEND the request
��Select the Response Body (Preview) tab to view assets returned

��Append the following filter clause to the end of the URL
?filter=type=Diesel-electric:model=SD70ACe

Note: The : symbol denotes an AND operation
��SEND the request
��Verify the correct subset of locomotive objects are returned

1. Add a filter to query all locomotives of type Diesel-electric.

2. Query locomotives that are Diesel-electric and are a model of SD70ACe.
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Note: up until this point, you have constructed filters with simple attributes; now you will 
add a filter with an attribute that references another domain object.

��Append the following filter clause to the end of the URL
?filter=engine=/engine/v12-6

(the “/engine/” references a path to the engine domain object)

��SEND the request
��A single locomotive object is returned

��Change the URL to reference the engine domain object
https://predix-asset.run.aws-usw02-pr.ice.predix.io/engine

��Append the following filter clause to the end of the URL
?filter=type=Diesel-electric>engine

��SEND the request
��All engines that are part of Diesel-electric type locomotives are returned
��Query Logic

��The query first returns all objects with a type property=Diesel-electric
��From that result set, find all objects that have an engine relationship to other objects
��From that new set of objects, return only engine objects

3. Query locomotives that have an engine type of v12-6.

4.  Construct a forward-relate query to retrieve.
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��Change the URL to reference the fleet domain object
https://predix-asset.run.aws-usw02-pr.ice.predix.io/fleet

��Append the following filter clause to the end of the URL
?filter=name=CSX<customer

��SEND the request
��All fleets owned by customer “CSX” are returned

��Query logic:
��The query first returns all objects with a name property of CSX
��From those objects, traverse backwards on the customer relationship (this returns 

another set of objects)
��From that new set of objects, return only fleet objects

5. Construct a backwards-relate query to retrieve fleet assets for customer CSX.



Lab 6 : Using the Asset Service

 GE Digital Page 132

Exercise 9: Constructing Transitive Closure Queries

Overview
In this exercise you work with the asset data model which is more representative of a hierarchical 
structure containing many levels of objects. You use the transitive closure operator to traverse 
the asset model and return all asset objects for each level specified in the query.

Steps

��Submit a GET request to return all objects in the asset collection
��Change the URL to reference the asset collection

https://predix-asset.run.aws-usw02-pr.ice.predix.io/asset
��The request returns all objects in the data model (partial list shown here)

1. Explore the asset data model.
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 Things to note:
 In the JSON, notice that the parent attribute is used to link asset objects between 
hierarchy levels. 
 For example, the aircraft object has no parent attribute which distinguishes it as the 
top-most parent object in the hierarchy. The aircraftEngine object has a parent 
attribute that points to the /asset/aircraft object. This indicates that 
aircraftEngine is a child to aircraft, and so on.

��Append a filter clause (bolded here) to the GET request URL
 https://predix-asset.run.aws-usw02-pr.ice.predix.io/asset?filter=n
ame=crankShaft>parent[t3]

��The query retrieves 3 levels of parent objects for all crankShaft objects 

2. Execute a forward-relate transitive closure to retrieve parent assets of crankShaft.
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 Query execution logic
��?filter=name=crankShaft returns all assets with a name attribute of crankShaft
��>parent[t3] - from those crankShaft objects, traverse the parent relationship in a 

forward (upwards) direction
��The query returns the following asset objects:

��aircraftMotor
��aircraftEngine
��aircraft

��Append a filter clause (bolded here) to the GET request URL
 https://predix-asset.run.aws-usw02-pr.ice.predix.io/asset?filter=n
ame=aircraftMotor<parent[t2]
 
 Query execution logic
��?filter=name=aircraftMotor will return all assets that have a name attribute of 

aircraftMotor

��<parent[t2] - from those aircraftMotor objects, traverse the parent relationship in a 
backward (downward) direction

��The query returns the following asset objects:
��crankShaft
��cylinder

��Experiment with different token [t] levels to traverse up and down the parent relationship 
in the hierarchy.

3. Execute a backwards-relate transitive closure.
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Lab 7:  Working with Analytics

Part I: Your Dev Environment and UAA

Learning Objectives
By the end of this lab, students will be able to:

��Create and bind the Analytics service instances to an application
��Configure the UAA service instance for authorization and access

Lab Exercises
��Create and Bind an Analytics Catalog Service Instance, page 137
��Create and Bind an Analytics Runtime Service Instance, page 141
��Updating the OAuth 2 Client, page 144
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Exercise 1: Create and Bind an Analytics Catalog Service 
Instance

Overview
Before you begin this exercise, make sure that:

��an instance of the UAA service has been configured as your trusted issuer. 
��an application has been bound to your UAA service instance

Steps 

cf marketplace (or cf m)

The Analytics Catalog service, predix-analytics-catalog, is listed as one of the available services.

1. List the services in the Cloud Foundry marketplace.
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��In an earlier lab, you bound an application to your UAA service instance. Use the following syntax 
to view the UAA environment variables associated with that application:

cf env <app_name> 
��Copy the environment variables from the Terminal into a new file in your text editor

Your file will look similar to the graphic below and you will use the Issuer ID when you 
create your analytics catalog service instance (next step).

2. View and record your your UAA environment variables. 
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��Use the following syntax to create your analytics catalog service instance:
cf create-service predix-analytics-catalog <plan> 
<my_catalog_instance> -c 
'{“trustedIssuerIds”:[“<uaa_instance1_issuerId>”]}'

where:
��<plan> is the pricing plan associated with a service.
��<my_catalog_instance> is the name of your analytics catalog service instance.
��<uaa_instance_issuerId> is the issuerId of your UAA service instance (refer to your gedit 

text file). 
For example:

3. Create your catalog service instance.
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��From your terminal: 
cf bind-service (or cf bs) <app_name> <my_catalog_instance>

 For example: 

4. Bind your application to your Analytics Catalog Service Instance. 

Note: You must bind your Analytics Catalog service instance to your application to 
provision connection details for your Analytics Catalog service instance in the 
VCAP_SERVICES environment variable
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Exercise 2: Create and Bind an Analytics Runtime 
Service Instance

Overview
You will follow similar steps to create the analytics runtime service instance.

Steps 

��Use the following syntax to create your analytics runtime service instance
cf create-service predix-analytics-runtime <plan> 
<my_runtime_instance> -c 
'{“trustedIssuerIds”:[“<uaa_instance1_issuerId>”, 
“<uaa_instance2_issuerId>”]}'

where:
��<plan> is the pricing plan associated with a service.
��<my_runtime_instance> is the name of your analytics runtime service instance.
��<uaa_instance1_issuerId> is the issuerId of your UAA service instance. 
��<uaa_instance2_issuerId>1: is the issuerId provided in the 2nd_id.txt file in your 

predix/PredixApps/training_labs/AnalyticsLabFiles folder
For example:

1. Create your Analytics runtime service instance, which will require two issuer IDs. 

1.  This second trusted issuer ID is required to run the job scheduler. A "beta" URL is provided. 
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��From your terminal: 
cf bind-service (or cf bs) <app_name> <my_runtime_instance>

For example:

2. Bind your application to your Analytics Runtime Service Instance. 
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��List the environment variables using the following command:
cf env <app_name> 

In this example, the system returns: 

��Copy this text to your gedit text file for future reference. 

3. View and record some key environment variables. 

Tip: Be sure to copy all of the environment variables into a file for later use.
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Exercise 3: Updating the OAuth 2 Client

Overview
To enable applications to access the Analytics Catalog and Runtime services, your JSON Web 
Token (JWT) must contain both of the following zone_auth_scope values, found in your 
application environment variables:

analytics.zones.<catalog_instance_guid>.user
analytics.zones.<runtime_instance_guid>.user

The OAuth2 client uses an authorization grant to request an access token. OAuth2 defines four 
grant types. Based on the type of authorization grant that you have used, you must update your 
OAuth2 client to generate the required JWT. 

This lab exercise will show you how to edit the scope of the access to include Catalog and 
Runtime services. 
In this exercise you will update the OAuth 2 client with the required scopes to work with the 
Analytics Catalog and Runtime services.

Steps

You will use the UAA command line interface (UAAC) to work with your UAA instance. This has 
been installed on the DevBox for you and information on this topic is in the Predix.io web site.
��From your Terminal, enter the following command:

uaac target <uaa_instance_url>
 where: <uaa_instance_url> is the URL of your UAA service instance (saved in your gedit 
text file).

1. Target your UAA service instance.
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��Log in and verify your default administrator account and password. You generated these when you 
created your UAA service instance in a prior lab. Refer to the password you wrote down at that time.

��Use the following command:
uaac token client get admin

 You are prompted for your administrative password (Client secret)
��Enter the admin password you created at the prompt. 

 The system responds with a message that you have successfully fetched a token via the 
client credentials grant with a context of admin, from client admin.
 

��Run the following command: 
uaac clients

 You will see the following information based on the client authorities you created in the 
security lab. You will update (add to) these in the next step:
 

��Copy this set of authorities into a new text file in gedit.

2. Log into your UAA service instance.

3. Update the OAuth2 client with the authorities (scopes) required.
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��Run the following command:
uaac client update <client> --authorities “<set_of_authorities>”

where <client> is the name of the uaa client you created in the Security lab.
where <set_of_authorities> is your existing set of authorities (copied from your 
Terminal as shown above), plus authorities required for the platform services 
(analytics catalog and runtime). 

��As in the following example:

 The two highlighted lines above are examples of the OAuth scopes for the catalog and 
runtime services. You retrieve these from your application’s environment variables. Copy 
these values from the zone-oauth-scope variable(s) under the predix-analytics-catalog 
and predix-analytics-runtime environment variables (one from each).

��Run the following command to retrieve the updated set of authorities
uaac clients

 After running the command, you can see that the for the client authorities have been 
updated to include the additional authorities for your catalog and runtime services.

Tip: Listed authorities have a single space between them. Be sure to include opening and 
closing quotation marks with the statement. Use your gedit text editor to collect the 
authorities before entering the final command in the Terminal.



Predix Developer Boot Camp

Page 147 Predix Training Programs

��Run the command:
uaac token client get client

��Validate with UAAC that the scopes were updated in the token by running the command:
uaac token decode

��You can also look at the scopes using the uaac clients command:

 Note the updated values for scope and also the grant type. 

4. Get the token again with the client credential grant.
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Part II: Working with the Analytics Catalog through a REST Client

Overview
By the end of this lab, students will be able to:

��Configure and use Postman (a REST client) to work with the API
��Set up appropriate authorization and access for Analytics Catalog and Runtime
��Create a catalog entry, upload an analytic executable, test and validate the analytic

Lab Exercises
��Using Postman and Getting Your UAA Token Value, page 149
��Working with the Analytics Catalog, page 164
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Exercise 1: Using Postman and Getting Your UAA Token Value

Overview
In this exercise, you will be using Postman, a Chrome browser extension, which allows you to:

��Create and send any HTTP request using the awesome Postman Builder. Requests are 
saved to history and can be replayed later.

��Manage and organize your APIs with Postman Collections for a more efficient testing and 
integration workflow.

 A screen shot of Postman follows:
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Environment variable values may be viewed when managing the environments. 
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You will use your application environment variables and Postman’s Collections manager to 
configure HTTP requests to your UAA service instance, and to your Analytics Catalog and 
Runtime service instances.
The example above shows the environment variables needed for the Analytics services. Variable 
values are referenced using double curly bracket notation (ex: {{token}}) in the request (URL, 
params, header, body). Different variables are used for different types of HTTP requests.

For example: 

The variables protocol, catalog_uri, token, and catalog_tenant were created with their 
corresponding values and are maintained in Postman’s environment manager. 
In this exercise, You retrieve a security token to make REST calls to your Analytics catalog and 
runtime services. You use Postman to make this call to your UAA service instance. 
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Steps

��Go to the Applications menu in the DevBox
��Choose Chromium Apps
��Click Postman 

��Click the Import button (top of page) in Postman. 
��Click Choose Files

��Browse to predix/PredixApps/training_labs/AnalyticsLabFiles for the Postman 
"dump" file called

 Analytics_Backup_2016-02-04.postman_dump
��Click Open, then Import. 
��A Collection already exists window appears. Close the window without selecting either 

button. If you get two collections with the same name, simply delete one of them.

1. Open the Postman tool.

2. Import Postman collections to facilitate API requests.
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��Click the Collections tab of Postman which should now contain the collections as shown 
(partial list): 

��Select Analytics-00 environment. 
��Then, click Manage Environments. 

3. Set your Postman environment for Analytics. 
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��Open the Postman Analytics-00 environment variables:  

��Set the following variables where:
��protocol: https (may already be set)
��UAA Token URL: UAA instance, “issuerId” value/URL (shown below, do not include the 

“https://”) 
��X-Identity-Zone-Id: UAA instance http-header-value 

4. Set your Postman environment for Analytics. 
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The variables should be set as follows: 

��Click Update
��Close the Manage environments window

��Expand Get Token under Collections
��Select POST Get Token

5. Create the Get Token request for your UAA client in Postman. 



Lab 7: Working with Analytics

 GE Digital Page 156

��Enter the UAA client authorization data
��Click the Authorization tab
��Select Basic Authentication under the Type menu

��Change the body of the request by removing the client ID and password (leave in grant 
types)

��Enter:
–  Username: <UAA_client>
–  Password: <client_password> 

��Click Update request
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 This will add the Authorization header to your token request. 
��Verify Header data

1. Ensure your Postman is in the Analytics-00 environment 
2. Drag and drop your headers so they appear in the following order
3. Click Send

This should result with a Status of 200 OK.
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 The access_token represents the UAA token value. Copy the text between the 
access_token quotes.
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��Paste the access_token value into the Postman variable “token”. 
��Click Analytics-00 Student 20160201/Manage environments

��Click Analytics-00 Student 20160201
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��Paste the copied token value into token
��Click Submit to save the variable

��Close the Manage environments window
��You can click Save response to keep an examples for future reference. Choose a name 

that fits the example, e.g. 200 OK - Client Token Request.
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��Click the Saved Response link to view 
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��To facilitate the other requests, set up the following environment variables:
��catalog_tenant (catalog - zone-http-header-value)
��runtime_tenant (runtime - zone-http-header-value) 

��Set Content-type: application/json.
��Click Submit. 

 Note that other variables have been set for you: catalog_uri, config_uri, execution_uri, and 
scheduler_uri.

6. Enter all the required Postman environment variables. 
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Exercise 2: Working with the Analytics Catalog

Overview
For this lab exercise, you will work with a simple Analytic application demo, upload it to the 
catalog, then deploy and test it. The application adds two numbers together. 
The following steps describe the process for adding a new analytic to the catalog. 

��Create the analytic.
��Upload the analytic to the catalog.
��Deploy and test the analytic in the Cloud Foundry environment

Steps

��If necessary, retrieve a new access token and paste it into the Token variable value for 
your environment.

��Add a new Postman tab (window) and select GET Retrieve All Analytics from the 
Analytic Catalog>Analytics folder structure

1. Get all analytic catalog entries. 
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��Click Send and you should receive a response status of 200 OK. 

��Review the body of the response, and note that there are no analytics entries as of yet. In 
the next steps, you will create a catalog entry and upload your sample analytic application. 

��Save (and update) this GET request to your Postman collection. 
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��Add a new Postman tab (window) and select POST Create Analytic from your Postman 
collections. 

��In the body of the request, replace existing text with the following: 

��Click Send, scroll down and you should see the following response:

��Note the id value created for the catalog entry (Catalog Entry ID) in the next step. 
��Optionally, Save (and update) this request to your Postman collection.

2. Create a catalog entry for your sample Analytic application.
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In this step, you will upload the sample analytic Java application to the Analytics Catalog.
��Add a new Postman tab (window) and select POST Create Artifact from your Postman 

collections under the Analytic Catalog>Artifacts folder.

 

��In Postman update the variable: analyticId (with the Catalog Entry ID) from the prior step 
response
��In the Body of the request, set or verify parameters as follows: 

–  type: Executable
–  description: This analytic adds 2 numbers and provides the sum.

3. Attach an executable artifact.
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��Click Choose Files to upload an artifact and attach it to an analytic catalog entry.
��Navigate to predix/PredixApps/training_labs/AnalyticsLabFiles and choose the 

demo-adder-java-1.0.0.jar file.
��Click Open to upload it for this catalog entry.

 

4. Upload an artifact and attach it to an analytic catalog entry.
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��You should receive the following response: 

��Copy the “id” value of the artifact and paste it into your Postman environment artifactId 
variable. 

��Optionally, save this request to your Postman collection, by clicking on the disk icon. This 
updates your collection request with the current parameters. 

��Add a new Postman tab (window) and select POST Validate Analytic from the 
Validation/Deployment/Execution folder of your Postman collections. 

��In the Body section, for <value1>, <value2>: Insert any two numbers you would like to add. 

��Click Send, and you should receive the following response:

5. Click Send to begin the upload.

6. Deploy and validate the analytic.
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��Copy and paste the validationRequestId to your Postman environment variables 
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��Add a new Postman tab (window) and select GET Retrieve Validation Status from the 
Validation/Deployment/Execution folder of your Postman collections. 

��Click Send, and you should receive the following: 

Note:  You may need to “Send” or poll it a few times to get a “completed” status. 

Exercise Summary
In this exercise you learned how to: 

��Create an Analytic Catalog entry.
��Upload the analytic artifact to the catalog for the assigned entry ID.
��Deploy and test the analytic in the Cloud Foundry environment.

7. Poll for the validation status.
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Part III: Runtime Orchestrations and Job Schedules

Learning Objectives
By the end of this lab, students will be able to:

��Understand and create an orchestration of an analytic
��Create, test and validate a job schedule for an analytic

Lab Exercises
��Running an Orchestration with One Analytic, page 173
��Schedule Orchestration and Analytic Execution (Scheduling a Job), page 181
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Exercise 1: Running an Orchestration with One Analytic

Overview
You will use the following information, from the previous lab, to run an orchestration:

��Analytic catalog ID
��Analytic name
��Analytic version

The following exercise walks you through the process for running an orchestration with one 
analytic. 

To facilitate learning, your Postman Collections under Orchestration Execution, there are two 
requests: 

��POST Run (Using sample bpmnXML)
Is available for the student to closely examine the sample bpmnXML workflow and sample 
orchestration request text by allowing the student to view and edit both items.  

��POST Run (Using environment variables) 
Is available for the student to simply run a “working” orchestration that relies on the 
environment variables: AnalyticId, AnalyticName, and AnalyticVersion.

��It is useful to have a working version for testing, validation, and comparison purposes of 
both requests. 

��The following steps are for use with the POST Run (Using sample bpmnXML) request. 
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Steps

��Add a new Postman tab (window) and select GET Retrieve All Analytics from the 
Analytic Catalog/Analytics folder of your Postman collections.

��Click Send. 

For this example, we are interested in the following Analytic info: 
       “version”: <v1>,
       “name”: <demo adder java 1>,
       “id”: <a14dae0b-17a7-40a3-b0a8-b0dbe59c4454>

��If not already done, add these values to your Postman environment variables.
��Analytics-00 Student/Manage environments

–   version: analyticVersion
–  name: analyticName
–  id: analyticId 

1. Get the ID, name, and version of the analytic to run an orchestration. 
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��Go to Predix.io and copy the sample BPMN workflow file at: 
 https://www.predix.io/docs#ODGDJxqF (See step 1 of Procedure of this web page) 

��Copy or download Running an Orchestration with One Analytic.

��Replace <Analytic Catalog Entry Id>, <Analytic Name> and <Analytic Version> with the 
analytic catalog entry ID, analytic name, and analytic version from the previous step.

Before editing:

2. Copy the sample BPMN workflow file with gedit.

3. Using gedit, paste and edit the sample BPMN workflow file.
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After editing:

��Save the file as Sample BPMN Workflow

��Add a new Postman tab (window) and select POST Run (Using Sample bpmnXML) from 
the Orchestration Execution Postman collection

.

4. Send an orchestration execution request. 
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The request has two important fields: bpmnXml and analyticInputData.
��bpmnXml: you will be replacing the current value with the BPMN workflow XML from the 

previous step after you “Escape for JSON”. (Step 5)
��analyticInputData: is an array of input data for the orchestration. Each element of 

analyticInputData array represents the input data for the corresponding service task in the 
BPMN workflow. In the BPMN workflow XML, the service task identified by 
/definition/process/serviceTask/@id. This service task id is correlated by 
analyticInputData.analyticStepId in JSON orchestration execution request. The input data 
for the service task can be specified with analyticInputData.data. (Step 6)

��Using Google, search for "Escape for JSON" and select the Escape tool as indicated below.  

��Paste the contents of the edited BPMN Workflow text in to the Escape tool, and click 
Escape to convert accordingly. 

5. Format the BPMN Workflow text using an “Escape for JSON” tool. 
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��Copy the “Escaped” text. 
��Return to Run (Using sample bpmnXML) in Postman, and paste the copied text into the 

bpmnXml field of the orchestration request text (replacing current text)

6. Copy the “Escaped” text and paste/replace the contents of the bpmnXml field of the 
Orchestration Execution Request (body of the Postman POST Run from the Orchestration 
Execution window).
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��Be sure to include the quotation marks for the content when replacing and ensure that 
only one set of opening and closing quotation marks enclose the field value as 
shown in the following image.

��Note that there is a comma at the end of the code.
��Check your Request parameters, and click Send
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��You should receive a response as follows:
 

��Optionally, save your API Request to your Postman collection (use the "disk" icon). 
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Exercise 2: Schedule Orchestration and Analytic 
Execution (Scheduling a Job)

Overview
Scheduling the execution of an orchestration or an individual analytic can be done on time-based 
intervals.
REST APIs are provided for managing a scheduled analytic or orchestration execution (also called 
a job). Using these APIs you can perform the following actions.

��Create a job definition
��Retrieve job definitions
��Retrieve job history
��Update job definitions
��Delete existing jobs

When creating or updating a job, you can enable a job execution by setting the job state to Active. 
To disable a job, set the state to Inactive.
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Steps

��Click Submit to save the variable. 

1. If needed, add the "scheduler_uri"  of your Runtime instance to your list of API variables. 
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��Open a new tabbed window in Postman, and select Retrieve All Jobs from the Scheduler 
Service.

��Click Send, and you should receive a response as follows:

Note that you currently do not have jobs scheduled.  

2. Check your scheduler to see if you have jobs ready to run. 
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Let’s take a look at the Postman configuration for creating a job. Add a new Postman tabbed 
window, and select POST Create Job from the Scheduler Service collection. 

3. Schedule a job. 
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��Edit the text of the body to set up a job schedule to trigger every 2 minutes on exactly 
every 2 minute mark. The following image shows all the fields that will need editing. 
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��Edit/Add the following fields and values as follows:
    "seconds": "0",
    "minutes": "0/2",
    "url": "<Runtime Instance execution_uri>",
    "httpMethod": "POST",
    "name": "Accept",
    "value": "application/json"
    "inputData": copy from Escape for JSON

Note: Be sure to include the open/closing quotation marks for the inputData field value. 

��Note the status returned of "201 Created" and the resulting job schedule.
��Update your Postman environment variables with the job Id.  

4. Click Send, and you should receive the following response: 
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��Add a new Postman tab (window) and select GET Retrieve All Jobs from the Scheduler 
Service collection. 

You should see a similar response as the following: 

5. Use the GET Request to Retrieve All Jobs, view your running job. 
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��Scrolling down, you’ll see the Job ID and status: 

��Enter the Job ID in the Postman environment variable and save it.
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��Add a new Postman tab (window) and select GET Job History By Job ID from the 
Scheduler Service collection. 

��Click Send and again after a few minutes, you should receive a response as follows: 

You can see the job being run every 2 minutes. Note the time stamp and the 2 minute intervals 
shown in the history. 

Exercise Summary
In this exercise you learned how to: 

��Create and validate an orchestration of an analytic
��Create, test and validate a job schedule for an analytic

6. View the Job schedule results by Get Job History by Job ID
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Lab 8:  Connecting Machines to Predix Cloud

Learning Objectives
��Become familiar with the Predix SDK and Predix OSGI Containers
��Configure a standard Predix Machine container to collect data from the Modbus adapter
��Configure a connection between Machine and Predix Cloud
��Create a basic bundle and deploy into the Machine services container
��Add security to a consumer bundle
��Generate gateway data using a machine adapter (Machine Gateway API)

Lab Exercises
��Using Predix SDK to Generate a Machine on page 191
��Generate and Capture Simulated Data on page 204
��Connect to the Cloud with the HTTP Data River and HTTP Service on page 216
��Working with Consumer Bundles on page 230
��Adding Security to Bundles on page 237
��Generate Gateway Data with the Machine Adapter on page 245

Directions
Complete the exercises that follow.
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Exercise 1: Using Predix SDK to Generate a Machine

Learning Objectives
The goal of this lab is to familiarize you with the Predix SDK and Predix OSGI Containers. 
At the end of the lab, you will have done the following

��Explore the Predix SDK
��Create and navigate a machine OSGI container
��Configure the web console to administer bundles in the container

��

Directions
Complete the exercises that follow. 
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Part I - Examine the Predix SDK

Steps 

��On the DevBox Desktop click the Places menu and select PredixApps from the list
��Open the training_labs/ machine/predixsdk-15.3.0 folder and examine the files

1. Locate the Predix SDK .
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��Open a Terminal  (Terminal icon on Desktop) and go to the docs directory
cd PredixApps/training_labs/machine/predixsdk-15.3.0 /docs

��Unzip the documentation file
unzip apidocs.zip -d apidocs

��Go to the samples directory and unzip the two sample folders
cd ../samples
unzip sample-apps.zip -d sample-apps
unzip sample-cloud-apps.zip -d sample-cloud-apps

��Open Eclipse (Eclipse-STS icon on Desktop)
��Ensure you are in the Predix SDK perspective (select the GE Predix SDK tab in the upper 

right corner of the tool)

��Click File > New > Other... > General > Project
��Click Next

��Project name: PredixMachineProject
��

��

��

��

��

��

2. Install the Machine documentation and samples.

3. Create a debug Machine container.

4. Create a new project that will hold the machine container image. 
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��Accept all other default settings and click Finish

��In the Navigator, select the PredixMachineProject and click on File > New > Image 
Description

��File name: predix-machine-debug
��Configure the Inherit Image section

��Workspace image: Predix Machine Debug (select from list)
Note: : If you do not select Predix Machine Debug you will not be able to open the Predix 
Administrator Console

(See next page)

5. Create a container image to use for the remainder of this training. 
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��Click Finish; a new tab predix-machine-debug will open in the editor window

��Platform Settings: verify 3 target platforms and JDK/JRE startup script are selected 

6. Export the Debug Machine Container.
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��Click the Export button in the top right corner (scroll the screen to the right to see the 
toolbar) 

��The OSGi image builder export wizard is opened
��Configure the export

��Check Create image in directory target for your container
��Destination: browse to 

PredixApps/training_labs/machine/predixsdk-15.3.0/utilities/containers
–  Click OK

��Click Finish and click Yes at the prompt
 A new folder predix-machine-debug is created with all the container files in the 
predixsdk-15.3.0/utilities/containers directory.

7. Export the container image.
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��On the Desktop click the File Finder icon and locate the predix-machine-debug container 
(hint: where you just exported it to) 

��It has the following structure:

 

8. Examine the exported container image folder contents.
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��In the Terminal, go to the /bin directory of predix-machine-debug
cd predixsdk-15.3.0/utilities/containers/predix-machine-debug/bin

��Run the start script using the command
./predixmachine clean

 The first time you start machine it will take a few minutes. Look for the Server is started 
message in the terminal window.

Part II - Test Administrator Command Line Options
In this exercise, you discover console commands to interact with the Machine services. 

Steps

��In the Terminal running the machine container
��If you don't see a fw>$ prompt, press return until you see fw>$ 
��Type ls (or list) at the command line to see the machine bundles in your container, 

along with their state

9. Start the debug container.

1. Discover available commands in the command line interface (CLI).
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��Notice the bundle id beside each one 

��Now try running these commands to display information about machine services

Command Action
? Displays list of all commands available
ls Lists the bundles
bundle <bundle Id> Displays bundle details
manifest <bundle Id> Displays the manifest of a bundle
services <bundle Id> Displays services provided by the bundle
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��Be aware of the following commands available through the terminal window but do not try 
them yet

��Leave the container running to do the next exercise

Part III - Using the Web Console
The Debug container can be managed in one of two ways: in a terminal window through 
command line options, or through a web interface. 

Steps

��In the Terminal, verify your machine container is running 
��In a Firebox browser navigate to: https://localhost:8443/system/console
��The following dialog box is displayed

Command Action
start <bundle Id> Start the bundle
stop <bundle Id> Stop the bundle
restart <bundle Id> Restart the bundle
e or exit Shutdown machine

1. Access the Web Console.
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��Click I Understand the Risks and then select Add Exception 
��Click Confirm Security Exception to complete the process

��Login using the following credentials
��Username: predix
��Password: predix2machine

��The console is displayed

 The Web Console administers all of the features offered by the Machine container. Once 
the container starts on the machine, all the functionalities are controlled through the UI. It 
is a personal preference whether to administer the console through the Admin Web 
Console or at the command line.

��Keep the container running for the next exercise

Note: Machine services use a self-signed certificate by default. You can safely add an 
exception to allow your browser to connect to Machine.

2. Log onto the Web Console.
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3. Try executing the following commands from the various menus in the web console.
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��Close the Administrator Web Console window (close the browser)
��In the Terminal at the fw? prompt, type exit to stop the machine container

 This will take a minute or two to bring everything down and return you to the terminal 
window prompt.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Men > Command Action

System > Shell Opens terminal window for command line option

OSGi > Bundles Displays full list of installed bundles

Technician Console > Configuration Displays bundle configuration files

Predix > Store and Forward Displays data files waiting for connection to be restored

4. Shut down web console and machine server.
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Exercise 2: Generate and Capture Simulated Data

Learning Objectives
By the end of the lab, students will be able to:

��Configure the Modbus adapter in the Machine container
��Configure a spillway for processing data
��Stage generated data through Data Store and Forward
��Configure a DDS Data River and move data locally
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Part I - Download and Start the Modbus PLC Simulator
In this exercise, you configure a standard Machine container to collect data from Modbus 
adapter.

Steps 

��In a browser go to http://sourceforge.net/projects/modbuspal/files/modbus 
��Download the ModbusPal.jar file

��In File Finder, navigate to the Downloads folder
��Copy the ModbusPal.jar file to the PredixApps/training_labs/machine folder

��From a Terminal navigate to ~/PredixApps/training_labs/machine
��Run the command to start the simulator

sudo java -jar ModbusPal.jar
��A new dialog window opens

Note: If your Predix Debug Machine is running, stop the container. You will restart after 
reconfiguring the bundles.

1. Download the Java ModbusPal simulator. 

2. Start the Modbus simulator.
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��In the Modbus slaves section, click Add to add a slave

��Select 1, update the Slave name to Asset1, and click the Add button

��Configure registers (sensors) for this asset 
��For Asset1, click on the edit button (the eye icon) 
��In the Holding registers tab, click the Add button

3. Configure the simulator.
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��Reset the number of registers 
��From: 10 (type this in)
��To: 13 (type this in)

–  Click Add

��Set the values for the registers to random numbers. The configuration should look similar 
to the picture below:

��Close the editor window by clicking on the X in the right corner
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��Add a second asset and configure the register range from 20 to 23

��Click the Run button to start the simulator

4. Add a second asset.
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Part II - Configure a Modbus Adapter in Machine Services
Predix Machine supports Modbus through the Modbus adapter bundle. This bundle must be 
configured to work with a given Modbus device. 

Steps 

��Open File Finder and navigate to 
/predix/PredixApps/training_labs/machine/predixsdk-15.3.0/utilities/containers/
predix-machine-debug/etc
��The configuration properties for the Modbus bundle can be found in 

etc/com.ge.dspmicro.machineadapter.modbus-0.xml. 
��Open this file in a text editor

1. Edit configuration settings for Modbus adapter.
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��Remove the TCP/IP comments for <dataNodeConfigs> (remove highlighted lines)

��Remove the TCP/IP comments for <dataSubscriptionConfigs> 

��Save the file

Note: This configures the Modbus adapter to listen for values on port 502 at IP address 
127.0.0.1. The Modbus PLC simulator software runs at this location by default.
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Part III - Configure a Spillway for DDS
The Data River service allows data to be passed through spillways for processing. In this example, 
we will set up a simple subscription-based spillway to listen to the Modbus adapter. 

Steps

��In a text editor, open the file etc/com.ge.dspmicro.hoover.spillway-0.cfg 
��Change the com.ge.dspmicro.hoover.spillway.destination property to 

Sender Service 

��Save the file

��In the Terminal, open a new tab (File > Open Tab)
��Navigate to the /bin directory of the predix-machine-debug folder

cd predixsdk-15.3.0/utilities/containers/predix-machine-debug/bin
��Start the machine container with the start script

./predixmachine clean
��Look for the message “Server is started” 

1. Set the spillway destination in the configuration file.

2. Collect "data forward" data.
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��In a browser, open Admin Web Console (https://localhost:8443/system/console)
��From the Predix menu, select Store and Forward
��Click DefaultStoreForward

 Within a minute you should see a numbered list of data objects being captured and stored 
every 60 seconds. Because there is no connection to the cloud yet, this data is saved. Only 
the last 10 data objects are shown. You will see errors in the terminal window until the 
data river is configured.

��Stop the Machine Container by typing exit in the Terminal (do not stop by using Ctrll+C)

3. View stored data in the Web Console.
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��In a text editor, open the etc/com.ge.dspnet.datariver.send-0.cfg file 
��Change the setting for secure transfer to: false

��Save and close the file

��In a text editor, open the etc/com.ge.dspnet.datariver.receive-0.cfg file
Note: The Data River Receiver service is configured to listen for a Data River Sender service 
in the same container by default. 
��Change the setting for secure transfer to: false

��Save and close the file

��From the /bin directory restart the machine container
./predixmachine clean

��Open the Admin Web console in a browser (https://localhost:8443/system/console)
��Select Predix >Store and Forward 

 The data under DataStoreForward is gone (it was sent to the data river receiver you just 
configured)

4. Configure the Data River Sender service.

Note: The Data River Send service is configured by default to transmit data from all 
spillways to configured Data River Receiver services. 

5. Configure the Data River Receiver service.

6. Restart the Machine and forward stored data.
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��In the terminal window you will see a success message repeated every few seconds

��In File Finder, navigate to 
predixsdk-15.3.0/utilities/containers/predix-machine-debug/appdata
/transfers/downloads 

Note: Because the DDS Data River endpoint defaults to localhost, the receiver will store 
data it receives in files in this directory.

7. View stored data in the file system.
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��You should see a new file created once every 60 seconds containing values from the 
Modbus PLC simulator

��The contents of the file are JSON formatted and should be similar to the following:
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Exercise 3: Connect to the Cloud with the HTTP 
Data River and HTTP Service

Learning Objectives
By the end of the lab, students will be able to:

��Configure a connection between machine and Predix Cloud
��Build and deploy an HTTP Data Service in Predix Cloud
��Configure the HTTP Data River in Predix Machine
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Part I - Cloud Foundry Setup
n this exercise you verify UAA and Postgres service instances using the Cloud Foundry CLI. These 
service instances will be used by the HTTP Data Service you will configure in the next exercise.

Steps 

��In the Terminal open a new tab and run the command: env |grep http 
��The values for http(s)_proxy and HTTP(S)_PROXY should not be set

��In the Terminal run the command: cf login
��Enter your login information

Email> student<XX> (where XX is any number from 2-50, e.g. student14)
Password> chang3m3
Space> 2

IMPORTANT: Make sure you are not behind a corporate firewall and there are no 
proxies set

1. Cloud Foundry setup.

2. Log into Cloud Foundry using your student credentials.
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��In the Terminal run the cf s command 
 Note the name of the postgres and UAA service instances you created in earlier labs.

��Stop the Machine Container by typing exit in the Terminal

3. Determine the names of your postgres and UAA instances.

4. Stop the Predix machine container.
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Part II - Import the HTTP Data Service Sample from the Predix SDK
In this section you import and build the HTTP Data Service sample that runs in the cloud. This 
service is the endpoint for the HTTP River sending data from Predix Machine.

Steps

��In Eclipse, select File > Import > Existing Maven Project, click Next, and browse to the 
samples folder in the predixmachinesdk

��Click Finish

1. Import a Maven project into Eclipse.
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��The HTTP Data Service sample imports as predixmachine-http-data project

��In the project open the manifest.yml file and update the following properties:
name: <your-name>-httpdata
services:
- <your-postgres-instance> 
- <your-uaa-instance>

��Replace <your-postgres-instance> with the name of the postgres instance you 
created in an earlier lab.

��Replace <your-uaa-instance> with the name of the UAA instance you created in 
an earlier lab.

–  For example:
name : student4-httpdata
services:
- student4-postgres 
- student4-uaa

��Save and close the manifest file

2. Update the manifest file.



Predix Developer Boot Camp

Page 221 Predix Training Programs

��In Eclipse, right-click on the project name and select Run As > Maven Install

��In the Terminal, navigate to the samples/sample-cloud-apps/httpdata folder (where the 
manifest.yml file is)

cd /predix/PredixApps/training_labs/machine/predixsdk-15.3.0/
samples/sample-cloud-apps/sample/httpdata

��Push the app to the cloud and make sure it starts
cf push
cf apps

3. Build the sample application.
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��Open a browser window and enter the application route followed by /v1/welcome 
http://<app_route/v1/welcome
Where <app_route> is the URL of the application you just pushed to the cloud. The 
route can be located with the cf apps command.

��You should see "Welcome to Predix Machine HTTP Data Service" indicating your service 
has been deployed successfully 

4. Test your application.
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Part III - Add a New Client ID to the UAA Instance

Steps

��Get the VCAP environment variables from your application
��In the Terminal run the command: cf env <your-name>-httpdata
��Copy the contents of UAA uri (don’t include the quotes)

1. Get the URL of the UAA instance.
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��Use the UAA command line interface (UAAC) to run the following commands:
uaac target <paste UAA uri here>
uaac token client get admin -s <admin_secret>

 Where <admin_secret> is the admin password you created in the security lab

��Create a new UAA client with the uaac client add command
��Run the command: uaac client add -i and press Enter
��You are prompted to fill in the following parameters (enter the bolded values)

client name: sample-clientid
new client secret: sample-clientid
verify client secret: sample-clientid
scope [list]: openid
authorized grant types [list]: authorization_code password 
client_credentials refresh_token
authorities [list]: uaa.resource

access token validity (seconds): press Enter
refresh token validity (seconds): press Enter 
redirect uri (list): press Enter 
autoapprove (list): openid
signup redirect url (url): press Enter

2. Get authenticated by the UAA instance and add a new client.
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��Get the VCAP environment variables from your application
��In the Terminal, run the command: cf env <your-name>-httpdata
��Copy the UAA issuerId value (do not include quotes)

3. Configure Cloud Foundry credentials.
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��Edit the /etc/com.ge.dspmicro.predixcloud.identity.cfg file
��Make the following changes to the file

 com.ge.dspmicro.predixcloud.identity.uaa.token.url= <UAA issuerid> (paste 
from cf env output)
 com.ge.dspmicro.predixcloud.identity.uaa.clientid= sample-clientid
 com.ge.dspmicro.predixcloud.identity.uaa.clientsecret=sample-clientid

��Save and close the file

Part IV - Configure Spillway for HTTP
Configure the HTTP Machine Services and start the flow of data.

Steps

��Edit the /etc/com.ge.dspmicro.hoover.spillway-o.cfg file
��Make the following changes to the file

com.ge.dspmicro.hoover.spillway.destination=Http Sender Service
��Save and close the file

��Get the application route by running the command cf apps in the Terminal

1. Configure the spillway for HTTP.

2. Configure the HTTP River.
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��Edit the /etc/com.ge.dspmicro.httpriver.send-0.cfg file
��Add the application route 

 com.ge.dspmicro.httpriver.send.destination.host=<application route>

Example:

��In the Terminal navigate to the /bin directory of predix-machine-debug
��Run the command ./predixmachine clean

��You will see a success message repeated for each transaction every few seconds

3. Restart the Predix Machine.
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��To verify that data is stored in the cloud, open a browser and retrieve a specific piece of 
data based on the transferId 
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��Stop ModbusPal by selecting the “x’ in the upper right corner of the ModbusPal tool or 
typing ctrl-c in the terminal window where ModbusPal was started from.

��Stop the Machine Container by typing exit in the Terminal 

4. Stop ModbusPal and shut down Machine.
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Exercise 4: Working with Consumer Bundles

Learning Objectives
By the end of the lab, students will be able to:

��Create a basic bundle that can be deployed into the Machine services container
��Use a maven archetype to quickly create a project with predefined components

Part I - Create a Basic Consumer Bundle
In this exercise, you create a basic bundle that can be deployed into the Machine services 
container. To simplify the process, you will use a maven archetype (a project template plug-in) to 
quickly create projects based on predefined project models.
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Steps 

��In Eclipse, verify you are in the Predix SDK perspective 
��From the File menu, select New > Maven Project

��Accept the default values and click Next 

1. Create a new Java project from a maven archetype.
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��In the Filter field, type machine to locate the machine-training-archetype
��Select the archetype machine-training-archetype, version 15.3.0 .

��Click Next 
��Enter the following parameters on the next screen

��Group Id: com.ge.predix.solsvc
��Artifact Id: machinetraining
��Package: com.ge.predix.solsvc.machinetraining

–  Click Finish
��A new project called machinetraining is displayed in the Navigator window

2. Select an archetype and define parameters.
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��Expand the machinetraining project and open the SimpleServiceImpl.java file 
��Locate the annotations for @Component, @Activate, and @Deactivate

��Open the pom.xml file and select the pom.xml tab in the editor window. 

��Locate the <packaging> tag 
–  This defines the build as an OSGI bundle

��Locate the <instructions> tag at the bottom of the file
–  These properties become part of the bundle manifest.mf file

3. Examine the project files.

Note: Do not select the drop-down for Packages in the Overview tab as this changes the 
packaging type.



Lab 8: Connecting Machines to Predix Cloud

 GE Digital Page 234



Predix Developer Boot Camp

Page 235 Predix Training Programs

��Right-click on the machinetraining project and select Run as > mvn install
��In the Console tab, the following messages are displayed

��Verify the BUILD SUCCESS message is displayed

��Start the machine container from the command line
��Reopen the Web Console

��In a Firefox browser navigate to https://localhost:8443/system/console
��Log in as username: predix password: predix2machine

��Click Install/Update... 

4. Build and deploy the maven project.

5. Deploy the bundle to the machine services container using the Web Console.
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��Select the bundle 
��Browse to the project's target directory located in the project workspace

/predix/Documents/MyProject/machinetraining
��Select the bundle name machinetraining-0.0.1-SNAPSHOT.jar

��Click the Install or Update.
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��Click on the Id column to sort the bundle list by descending order
 (If you do not see your bundle at the top, click Reload. The bundle should be in the Installed 
state)

��Under the Actions bar, click the Start button 
��You should see the message “this is a test string” in the terminal window where you 

started predix machine

6. Start the bundle from the Web Console.
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Exercise 5: Adding Security to Bundles

Learning Objectives
This goal of this lab is to provide hands on experience with:

��Adding a new machine service to your consumer bundle
��Using the security service to encrypt a variable in the consumer bundle configuration file
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Part I - Adding Security to a Consumer Bundle
In this exercise you add a new machine service to your consumer bundle. You then call the 
security utility APIs to encrypt the consumer bundle’s password.

Steps 

First you need to create the consumer's configuration file with a non-encrypted password. 
��Go to <predix-machine-debug>/etc folder and create a new configuration file 

��File name: com.ge.predix.solsvc.machinetraining.cfg 
 TIP: You may copy any of the existing .cfg files and remove the all the settings.

��Add the following 2 properties to the file
com.ge.predix.solsvc.machinetraining.uri=https://localhost:8443/testserve
r/test
com.ge.predix.solsvc.machinetraining.password=secretpassword

��Save and close the file

1. Create a configuration file for the consumer bundle.
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��In Eclipse, open the pom.xml file for the machinetraining consumer bundle

��Locate the comment <!-- DSP micro API package versions -->
 You will notice several <import.com.ge.dspmicro.<service>.api> statements. 
These define the range of supported API levels for the package that you are using in your 
application. 

��Ensure that the following import is listed:
<import.com.ge.dspmicro.security.admin.api>"[1.1,2.0)"</import.c
om.ge.dspmicro.security.admin.api>

��In that same file locate the <Import-Package> tag 
��If not already there, add the following package at the end of the package list:

com.ge.dspmicro.security.admin.api;version=${import.com.ge.dspmi
cro.security.admin.api}

2. Add a security package to pom.xml file,
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��Save and close the file.

��In the machine training project, locate the SimpleServiceImple.java file
��Add the following static field to your SimpleServiceImpl class just below the existing 

variables for SERVICE_PID and _logger:
private static final String PROP_PASSWORD = SERVICE_PID + 
“.password”;

 (this variable corresponds to the value you added to the configuration file)

Note: Make sure you check the syntax and place a comma separating this package from the 
one above it.

3. Create a variable for the configuration property.
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��In SimpleServiceImple.java add another private field to the class as a handle to the 
security service:

private ISecurityUtils        secUtils;

��If you get an error, press ctrl+shift+o to organize your imports 
��Select the following import: com.ge.dspmicro.security.admin.api

��Create a setter for this field annotated with @Reference
��Add the following code for the setter method just below the deactivate method

��Press ctrl+shift+o to organize your imports
��Select aQute.bnd.annotation.component from the list to import the following 

package into your app:
import aQute.bnd.annotation.component.Reference;

4. Add necessary code for consuming a new service.
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The activate method is guaranteed to be called when a service starts. This is a good place to 
encrypt a property.

��Add the highlighted code to the end of the activate method
this.secUtils.encryptConfigProperty(SERVICE_PID,PROP_PASSWORD);

��In order to use the encrypted property, access the value through security utils. 
��Add the following code just below the line you added in your activate method above 

_logger.info("Original Value : " + 
String.valueOf(this.secUtils.getDecryptedConfigProperty(SERVICE_
PID, PROP_PASSWORD)));

(Obviously you would never log a password in a real use case.)
��Your completed code should look like this

5. Implement security APIs.
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��Delete the machinetraining.jar from the running Predix Machine container before 
importing the updated app.

��Deploy the updated bundle 
��Select the Install/Update button 
��Browse to the updated machinetraining-0.0.1-SNAPSHOT.jar file and select open
��Select “Install or Update” to import the bundle 
��Click Start to launch the bundle.

��You will see the original password displayed in the terminal window where machine is 
running

6. Build the project and deploy the bundle.
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��Open the machinetraining.cfg file in the predix-machine-debug/etc folder
 The password field has been wiped out and an encrypted property has been appended to 
the file. 

��The configuration file will look like the following: 

The password is clearly no longer human readable. 

7. Verify that the property has been encrypted.
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Exercise 6: Generate Gateway Data with the 
Machine Adapter

Learning Objectives
At the end of this lab you will be able to:

��Read data from an adapter
��Create a simple adapter that returns random data
��Implement the interface and register the service with Machine Gateway
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Part I - Configure a Consumer Bundle
In this exercise you configure a consumer bundle.

Steps 

��In Eclipse, open the pom.xml file
��Locate the comment <!-- DSP micro API package versions -->

Notice several <import.com.ge.dspmicro.<service>.api> statements
��Ensure that the following import is listed: 

<import.com.ge.dspmicro.machinegateway.api>”[1.1,2.0)”</import.
com.ge.dspmicro.machinegateway.api>

��Locate the <Import-Package> tag
��If not already there, add the following 3 packages at the end of the package list

com.ge.dspmicro.machinegateway.api;version=${import.com.ge.dspmi
cro.machinegateway.api},

com.ge.dspmicro.machinegateway.api.adapter;version=${import.com.
ge.dspmicro.machinegateway.api},

com.ge.dspmicro.machinegateway.types;version=${import.com.ge.dsp
micro.machinegateway.api}

 

1. Verify that the machinegateway packages are imported into the consumer bundle.

Note: Make sure you check the syntax and place a comma separating these packages from 
the ones above.
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��If not already there, add the private field for Machine Gateway into your 
SimpleServiceImpl class

private IMachineGateway       gateway;
��Add the setter for the machine gateway field annotated with @Reference

@Reference
public void IMachineGateway gateway)
{
    this.gateway = gateway;
}

��Save your work

 An implementation has been provided for you as part of the archetype. Take a look at 
RandomMachineAdapter.java. It provides a mock implementation of a machine adapter. 
When readData is called from this adapter, it will return a random integer wrapped in the 
PDataValue class.

 In a real use case, this interface should be implemented using a Java library for whatever 
device technology with which this adapter will interface.

 Adapter type identifies an adapter. A common convention, which is also used by the 
Random Machine Adapter, is to use the service PID as the adapter type.

��Add this private field to the SimpleServiceImpl class
private UUID           randomNodeId; 

2. Add necessary code for consuming a new service.

3. Implement the IMachineAdapter Interface.

4. Retrieve the adapter through the Machine Gateway API.
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��Insert this code into your activate method, below the code you added in the previous labs
for (IMachineAdapter adapter : 
   this.gateway.getMachineAdapters())  {
     if ( adapter.getInfo() == null )
     {
         continue;
     }
     if ( 
RandomMachineAdapter.SERVICE_PID.equals(adapter.getInfo().getAdapt
erType()) )
      {
       this.randomNodeId = 
adapter.getNodes().get(0).getNodeId();
break;
      }
}

Now that you have the nodeId of the single node in the adapter, you can read it directly from the 
MachineGateway API. There are two ways to read data: either directly from the MachineAdapter 
or through MachineGateway. In this example you will read from MachineGateway so you do not 
have to store the reference to the adapter. 

��Add the following code just below the for{} loop you added in the previous step
PDataValue value = 
this.gateway.readData(this.randomNodeId);

_logger.info("Reading Random Value " + 
value.getEnvelope());

��Import PDataValue from com.ge.dspmicro.machinegateway.types if needed
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��Your completed code should look something like this 

��Build the machinetraining project (Run As > maven install)
��From the Web Console, delete the existing machinetraining bundle
��Select Import/Install and browse to the updated machinetraining.0.0.1-SNAPSHOT.jar
��Import the updated bundle and start

5. Build and deploy your bundle. 
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 Boot Camp Appendix
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Installing Px Theme Components from GitHub

��Connect to the px-theme repository on GitHub
 You need a GitHub account as well as a Predix.io account to do this.

��On the right-hand side of the web page, click the HTTPS link under the HTTPS clone URL

��Copy the link in the box. You will use this in the next command in the Terminal window
��In the Terminal, change to directory into which the project should install

��cd ~/predix/PredixApps/training_labs

��Clone the px-theme library: 
git clone https://github.com/PredixDev/px-theme.git

 In the Terminal, you should receive confirmation that this has completed correctly.
��In the Terminal, run the following commands to set up your px-theme project:

��cd px-theme
��npm install
��bower install

Note: The following list is for your information only. It indicates the steps that you would 
normally take to set up your px-theme project. These were completed for you in order to 
provide the Px elements required for the lab exercises.



Predix Developer Boot Camp

Page 253 Predix Training Programs

The npm and bower install commands install dependencies for the application in 
the px-theme directory.

��In your browser, open the px-forms-design library in GitHub
��Copy the “bower install” line from the Readme information under the “Installation” heading

��In the Terminal, run this command:
 bower install --save https://github.com/PredixDev/px-forms-design.git

 This installs the px-forms-design module and its dependencies.
 

Creating a Web Component
��To Download the Yeoman generator for the Predix component, in the Terminal, run the 

following commands:
 git clone https://github.com/PredixDev/generator-px-comp.git
 cd generator-px-comp
 npm link
 The git clone command clones the generator from GitHub. The npm link command 
installs the generator-px-comp.

��To create a directory and run the Predix component generator, in the Terminal, run the 
following commands:
 mkdir hospital-info
 cd hospital-info
 yo px-comp
 The yo px-comp command runs the generator, which creates the new component. 
During this creation, you will be prompted for a component name, mix-ins, and PXd Sass 
modules. Answer the questions as follows:
 
��? What is the component’s name, must have a "-", e.g. ’px-thing’?

Enter my-table and press Enter

Tip: Look at the repository in GitHub for the PXd library to find styles or elements that can 
be used in your applications. You’ll use some styles from the px-forms-design component
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��?Optional: Local paths to mix-ins the component uses, comma-separated (e.g. 
’../px-my-mixin,../px-my-other-mixin’)
Press Enter

��?Which of these common Pxd Sass modules does your component need? (You can add 
more later in bower.jason)
Use your arrow keys to scroll down to Tables and press the Space Bar to select Tables

��Press Enter

 
��To download and install the Bower dependencies for the component, in the Terminal, run 

the following commands:
��bower install
 bower link
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